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Product Certifications

UL, cUL, TÜV, NOM-NYCE, CE, C-Tick, meets or exceeds FCC Class B 
requirements
Laser: CDRH on internal laser product 

Laser Safety

This unit employs a laser. Do not remove the cover or attempt to service this 
device when connected due to the possibility of eye damage.

Laser-Sicherheit

In das Gerät ist ein Laser eingebaut. Nehmen Sie die Abdeckung nicht ab und 
versuchen Sie nicht, das Gerät zu reparieren, solange es angeschlossen ist. Es 
besteht die Gefahr einer Augenverletzung.

CAUTION

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous laser radiation exposure.

WARNUNG

Die Vornahme von Regelungen oder Einstellungen oder die Durchführung von 
Verfahren, die nicht in diesem Dokument angegeben sind, kann eine gefährliche 
Einwirkung von Laserstrahlung zur Folge haben.

Contains: Class 1 Laser Product
Innehåller: Klass 1 Laserapparat
Sisältää: Luokan 1 Laserlaite
Enhält: Klasse 1 Laser-Produkt

DANGER: INVISIBLE LASER RADIATION WHEN OPEN. AVOID DIRECT 
EXPOSURE TO BEAM.

DANGER: RADIATIONS INVISIBLES DU LASER EN CAS D’OUVERTURE. EVITER 
TOUT EXPOSITION DIRECTE AU FAISCEAU.

VORSICHT: UNSICHTBARE LASERSTRAHLUNG, WENN ABDECKUNG 
GEÖFFNET. NICHT DEM STRAHL AUSSETZEN.

ADVARSEL: USYNLIG LASERSTRÅLING VED ÅBNING. UNDGÅ UDS/ETTELSE 
FOR STRÅLING.

ADVARSEL: USYNLIG LASERSTRÅLING NÅR DEKSEL ÅPNES. UNNGÅ 
EKSPONERING FOR STRÅLEN.

VARNING: OSYNLIG LASERSTRÅLNING NÄR DENNA DEL ÄR ÖPPNAD. 
STRÅLEN ÄR FARLIG.
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VARO! NÄKYMÄTÖN AVATTAESSA OLET ALTTIINA LASERSÄTEILYLLE. ÄLÄ 
KATSO SÄTEESEN.

Laser

Type: Semiconductor laser GaAlAs
Wave length: 778~787 nm (at 25°C)
Output power: 2.5 mW (read), 35 mW (write)
Beam divergence: 60 degrees

FCC Declaration of Conformity

According to 47CFR, Parts 2 and 15, Class B Computer Peripherals: 
This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference 
(2) this device must accept any interference received including interference that 
may cause undesired operations. This applies to all product options.

Hewlett-Packard Company
Colorado Personal Storage Solutions Division
800 S. Taft Ave., Loveland, Colorado 80537, USA 
Telephone 970-635-1500

November 2, 1998
Todd Hammel, Manufacturing Manager
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Federal Communications Commission R.F. Interference 
Statement

WARNING: This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television reception, 

DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name:

Manufacturer’s Address:

declares that the product:
   Product Name:
   Product Number:
   Product Options:

Hewlett-Packard Company
Colorado Personal Storage Solutions Division

800 S. Taft Ave.
Loveland, Colorado 80537

HP SureStore CD-Writer Plus 7500e, 7510e
C4413A, C4412A
All

conforms to the following Product Specifications:

Safety:

EMC:

Supplementary Information

EN60950: A4:1995
EN60825-1: 1994

CISPR 22: 1993/EN 55022:1994 Class B
EN 50082-1:1992
   IEC 801-2:1991 - 4kV CD, 8kV AD
   IEC 801-3:1984 - 3V/m
   IEC 801-4:1988 
       1kV Power Lines
        0.5kV Signal Lines
ENV 50140:1993 - 3V/m
EN 61000-3-2: 1995 Class D
FCC Part 15 Class B
AS/NZS 3548: 1995
IEC 555-2

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and 
the EMC Directive 89/336/EEC and carries the “CE” mark accordingly.

November, 2, 1998 Todd Hammel, Manufacturing Manager

European contact: Your local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, 
Department HQ-TRE, Herrenberger Straβe 130, D-71034 Böblingen (FAX: +49-7031-143143).
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which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications to this equipment not expressly approved by 
Hewlett-Packard could result in violation of Part 15 of the FCC rules.

To maintain compliance with FCC rules and regulations, use properly shielded 
cables with this device.

Notice for Canada 

This digital apparatus does not exceed the Class B limits for radio noise emissions 
from digital apparatus as set out in the radio interference regulations of the 
Canadian Department of Communications.

Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les 
limites applicables aux appareils numériques de Classe B prescrites dans le 
règlement sur le brouillage radioélectrique édicté par le Ministère des 
Communications du Canada.

Notice

Europe: This drive shall be installed only with an EN60950 (IEC950) approved 
Power supply.

USA/Canada: This drive is for use only with IBM compatible UL listed personal 
computers, weighing less than 18 kg.

User’s manual statement for VCCI class B product

Translation for VCCI class B product

This equipment is in the Class B category information technology equipment 
based on the rules of Voluntary Control Council For Interference by Information 
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Technology Equipment (VCCI). Although aimed for residential area operation, 
radio interference may be caused when used near a radio or TV receiver.

Read the instructions for correct operation.

BAPT Statement

Diese Ausrüstung erfüllt die Europäischen EMC-Bestimmungen für die 
Verwendung in folgender / folgenden Umgebung(en):

■ Wohngegenden
■ Gewerbegebiete
■ Leichtindustriegebiete

(Diese Ausrüstung erfüllt die Bestimmungen der Norm EN55022, Klasse B.)

Korean RRL Statement

Copyright notice for Denmark:

VIGTIGT! 

Copyright ved brug af CD-Writer 7500e, 7510e enheder 
solgt i Danmark

I henhold til gældende dansk lov om ophavsret er det forbudt at foretage digital 
kopiering af et digitalt værk. CD-RW brænderen må derfor IKKE anvendes til at 
kopiere en musik-CD. CD-RW brænderen må desuden kun benyttes til at kopiere 
et digitalt EDB-program, når en sådan kopiering tjener til at fremstille et 
sikkerhedseksemplar af programmet eller hvor kopiering er nødvendig, for at 
programmet kan anvendes efter dets formål. Hvis De selv har ophavsretten til 
værket, har De også retten til at foretage digital kopiering med CD-RW brænderen.
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Hewlett-Packard Limited Warranty Statement

HP SureStore CD-Writer Plus Drive
DURATION OF LIMITED WARRANTY           Hardware - 1 year      Software - 90 days

1.   HP warrants to you, the end-user customer, that HP hardware, accessories and 
supplies will be free from defects in materials and workmanship after the date of 
purchase, for the period specified above. If HP receives notice of such defects 
during the warranty period, HP will, at its option, either repair or replace products 
which prove to be defective. Replacement products may be either new or like-new.

2.   HP warrants to you that HP software will not fail to execute its programming 
instructions after the date of purchase, for the period specified above, due to 
defects in material and workmanship when properly installed and used. If HP 
receives notice of such defects during the warranty period, HP will replace 
software media which does not execute its programming instructions due to such 
defects.

3.   HP does not warrant that the operation of HP products will be uninterrupted 
or error free. If HP is unable, within a reasonable time, to repair or replace any 
product to a condition as warranted, you will be entitled to a refund of the 
purchase price upon prompt return of the product.

4.   HP products may contain remanufactured parts equivalent to new in 
performance or may have been subject to incidental use.

5.   Warranty does not apply to defects resulting from (a) improper or inadequate 
maintenance or calibration, (b) software, interfacing, parts or supplies not 
supplied by HP, (c) unauthorized modification or misuse, (d) operation outside of 
the published environmental specifications for the product, or (e) improper site 
preparation or maintenance.

6.   HP MAKES NO OTHER EXPRESS WARRANTY OR CONDITION WHETHER 
WRITTEN OR ORAL. TO THE EXTENT ALLOWED BY LOCAL LAW, ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY, SATISFACTORY QUALITY, 
OR FITNESS FOR A PARTICULAR PURPOSE IS LIMITED TO THE DURATION OF 
THE EXPRESS WARRANTY SET FORTH ABOVE. Some countries, states or provinces 
do not allow limitations on the duration of an implied warranty, so the above 
limitation or exclusion might not apply to you. This warranty gives you specific 
legal rights and you might also have other rights that vary from country to 
country, state to state, or province to province.

7.   TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS 
WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT 
AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE 
FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL 
(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED 
IN CONTRACT, TORT, OR OTHERWISE. Some countries, States or provinces do 
not allow the exclusion or limitation of incidental or consequential damages, so 
the above limitation or exclusion may not apply to you.

FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND: THE 
WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT 
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN 
ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE 
SALE OF THIS PRODUCT TO YOU.
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HEWLETT-PACKARD YEAR 2000 WARRANTY

FOR CONSUMER PRODUCTS DISTRIBUTED THROUGH RESELLERS

Subject to all of the terms and limitations of the HP Limited Warranty Statement 
provided with this HP Product, HP warrants that this HP Product will be able to 
accurately process date data (including, but not limited to, calculating, comparing, 
and sequencing) from, into, and between the twentieth and twenty-first centuries, 
and the years 1999 and 2000, including leap year calculations, when used in 
accordance with the Product documentation provided by HP (including any 
instructions for installing patches or upgrades), provided that all other products 
(e.g. hardware, software, firmware) used in combination with such HP Product(s) 
properly exchange date data with it.  The duration of the Year 2000 warranty 
extends through January 31, 2001.
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HP Software License Agreement

ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE 
LICENSE TERMS SET FORTH BELOW. USING THE SOFTWARE INDICATES YOUR 
ACCEPTANCE OF THESE LICENSE TERMS. IF YOU DO NOT ACCEPT THESE 
LICENSE TERMS, YOU MAY RETURN THE SOFTWARE FOR A FULL REFUND. IF 
THE SOFTWARE IS BUNDLED WITH ANOTHER PRODUCT, YOU MAY RETURN 
THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND. 

HP SOFTWARE LICENSE TERMS

License Grant. HP grants you a license to Use three (3) copies of the Software but 
only for Use in conjunction with the HP hardware product that accompanied the 
Software. “Use” means storing, loading, installing, executing or displaying the 
Software. You may not modify the Software or disable any licensing or control 
features of the Software.

Ownership. The Software is owned and copyrighted by HP or its third party 
suppliers. Your license confers no title or ownership in the Software and is not a 
sale of any rights in the Software. HP's third party suppliers may protect their 
rights in the event of any violation of these License Terms.

Copies and Adaptations. You may only make copies or adaptations of the 
Software for archival purposes or when copying or adaptation is an essential step 
in the authorized Use of the Software. You must reproduce all copyright notices in 
the original Software on all copies or adaptations. You may not copy the Software 
onto any bulletin board or similar system.

No Disassembly or Decryption. You may not disassemble or decompile the 
Software unless HP's prior written consent is obtained. In some jurisdictions, HP's 
consent may not be required for limited disassembly or decompilation. Upon 
request, you will provide HP with reasonably detailed information regarding any 
disassembly or decompilation. You may not decrypt the Software unless 
decryption is a necessary part of the operation of the Software.

Transfer. Your license will automatically terminate upon any transfer of the 
Software. Upon transfer, you must deliver the Software, including any copies and 
related documentation, to the transferee. The transferee must accept these License 
Terms as a condition to the transfer. 

Termination. HP may terminate your license upon notice for failure to comply 
with any of these License Terms. Upon termination, you must immediately 
destroy the Software, together with all copies, adaptations and merged portions in 
any form.

Export Requirements. You may not export or re-export the Software or any copy 
or adaptation in violation of any applicable laws or regulations.

U.S. Government Restricted Rights. The Software and any accompanying 
documentation have been developed entirely at private expense. They are 
delivered and licensed as “commercial computer software” as defined in DFARS 
252.227-7013 (Oct 1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227-
7014 (Jun 1995), as a “commercial item” as defined in FAR 2.101(a), or as 
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“Restricted computer software” as defined in FAR 52.227-19 (Jun 1987)(or any 
equivalent agency regulation or contract clause), whichever is applicable. You 
have only those rights provided for such Software and any accompanying 
documentation by the applicable FAR or DFARS clause or the HP standard software 
agreement for the product involved
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Chapter 1:
Connecting CD-Writer 
Plus and Installing 
Software

What’s in Your Package
Make sure you have the items shown below. (Keep the packaging in case 
you need to transport the CD-Writer Plus drive.)

User’s 

Blank 

Data cable

Power

Power

Audio
cable

Driver
installation diskette

HP SureStore CD-Writer Plus

Guide

cord

 supply

Recordable
CD  

 

Software installation CDs

drive
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1-2 Connecting CD-Writer

Connecting CD-Writer
CAUTION: The CD-Writer Plus drive contains sensitive, high-precision optical 
equipment. Dropping or shaking the CD-Writer Plus drive may cause damage 
to these sensitive components. Please be careful when handling your drive.

NOTE: Refer to the manual that came with your computer if you need more 
information than what is provided here.

WARNING: DO NOT, under any circumstances, open the external CD-Writer 
Plus drive’s case. If you suspect problems with your drive, service must be 
performed by a certified HP technician. See ”Appendix B:  Customer Support”.

1. Shutdown Windows and turn OFF your computer.

NOTE: The CD-Writer Plus drive can be used with laptops, desktops, and 
towers that meet “Minimum System Requirements” on page A-1.

2. Connect one end of the power cord into the power supply and the other 
end to a wall outlet or power strip. (The power plug and outlet may look 
different in your country.)

Power supply

To CD-Writer Plus drive

Power cord

Green light
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3. Connect the power supply to the power connector on the back of the 
CD-Writer Plus drive, with the arrow on the cable facing up.

Check that you have power to the CD-Writer Plus drive by opening and 
closing the CD tray by pressing the eject button. 

NOTE:  There is no power switch on the CD-Writer Plus drive or power supply. 
The energy-efficient power supply automatically switches into power-saving 
mode when the drive is not in use, and may be safely left plugged in at all 
times. However, you may safely unplug the power supply without causing 
damage to the CD-Writer Plus drive.

(arrow up)

Power connector

To power supply
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1-4 Connecting CD-Writer

4. Locate the parallel port (printer port) connector on your computer. 

If you are having trouble finding the parallel port connector, your printer 
may already be attached to it. The CD-Writer Plus drive can share the 
parallel port with your printer.

If the CD-Writer Plus drive and your printer will share the parallel port, 
go to the next step. 

If the CD-Writer Plus drive will not share the parallel port with your 
printer, proceed to step 6.

Select an available parallel port. 

TIP: Your CD-Writer Plus drive can share 
a parallel port with a printer.

Parallel ports have 
receptacles for 25 
pins.
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5. If you have a printer cable attached to the computer’s parallel port, 
disconnect it from the computer and plug it into the CD-Writer Plus 
drive’s connector that is closest to the power cord connector.

CAUTION: Do not plug any device other than a printer into the CD-Writer Plus 
drive’s printer connector.

NOTE: If your printer is attached to the CD-Writer Plus drive, printing 
documents while using the rewritable CD drive (for example, playing audio 
CDs, writing to disc) will yield unpredictable results and is not a supported 
function. This is because the printer and CD-Writer Plus drive are sharing the 
same data cable.

Secure the connector 
by tightening the 
retaining screws.

Printer’s data cable
(If a printer is sharing the 
parallel port with the CD-
Writer drive.)

Power cord connector

Printer connector
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1-6 Connecting CD-Writer

6. Attach the CD-Writer Plus drive’s  data cable to your computer’s 25-pin 
parallel port connector and hand tighten the retaining screws.

Attach the data cable’s remaining connector to the rewritable drive and 
secure it by tightening the retaining screws.      

CD-Writer Plus drive’s data cable

Attach this end to the CD-
Writer Plus drive.

Attach this end to the 
computer’s parallel port.

Download from Www.Somanuals.com. All Manuals Search And Download.



Connecting CD-Writer 1-7 C
h

ap
ter 1:  C

o
n

n
ectin

g
 C

D
-

W
riter P

lus an
d

 In
stallin

g
 

So
ftw

are

7. Connecting the audio cable is OPTIONAL. If you do not wish to use it, go 
to step 10.

The audio cable is used only for hearing music CDs through your 
computer’s sound system. If you do not have a sound board in your 
computer, you can still hear music CDs through speakers or earphones 
attached to the front of the CD-Writer Plus drive.

NOTE: When the CD-Writer Plus drive records music or data, it uses the data 
cable, not the audio cable.

8. If you have a sound board, connect the audio cable to a LINE IN audio 
connector on the back of your computer. (Your sound board may be 
labeled differently.)

9. Connect the other end of the audio cable to the audio connector on the 
back of the CD-Writer Plus drive.

10. Plug in and turn ON your computer.

11. You are now ready to install the parallel port drivers and the application 
software. (See “Installing the Software for Windows 95/98, or Windows 
NT 4.0” on page 1-8.)

Audio cable

Audio connector

(optional)

LINE IN connector on
sound board (Your sound
board may be labeled
differently.)
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1-8 If You Have Problems

If You Have Problems
After connecting your CD-Writer Plus drive and turning on your 
computer, the computer should start (boot) as it normally does. If it does 
not, check the following items: 

■ Is the computer power plugged in? 

■ Is each device plugged in and turned on? 

■ Are all cables properly plugged into the back of your computer and 
the CD-Writer Plus drive? 

■ Try turning off your computer. Wait at least 20 seconds before turning 
it back on.

Installing the Software for Windows 
95/98, or Windows NT 4.0

After the CD-Writer Plus drive is attached to your computer, you are 
ready to install the application software.

If your computer DOES have a CD-ROM drive:

1. Insert the CD labeled “Software Disc 1” into your CD-ROM drive (not the 
CD-Writer Plus drive). The main menu appears:

Click the 
Install CD-
Writer Plus 
icon
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If the main menu does not appear automatically, click on the Start 
button on the task bar, select Run, type D:\SETUP (where D: is your CD 
drive’s letter), then click on OK. 

2. Click on the Install CD-Writer Plus icon. Follow the instructions on the 
screen.

If your computer DOES NOT have a CD-ROM drive:

1. To get your CD-Writer Plus started right away, insert the diskette labeled 
Driver Installation into your floppy drive.

2. Click the Start button on the task bar, select Run.

3. Type A:\SETUP (where A: is your floppy drive’s letter), and press ENTER. 
The parallel port driver files are installed. This may take several minutes 
and your mouse cursor will not move.

4.  If prompted to do so, reboot your computer.

5. Insert the CD labeled “Software Disc 1” into your new CD-Writer Plus 
drive. 

If the main menu does not appear automatically, click on the Start 
button on the task bar, select Run, type D:\SETUP (where D: is your CD 
drive’s letter), then click on OK. 

6. Click on the Install CD-Writer Plus icon. Follow the instructions on the 
screen.

If You Have Problems

Things to Try First

■ Make sure the computer and each device is plugged in and turned on.

■ Does your computer meet the minimum system requirements listed 
in “Minimum System Requirements” on page A-1?

■ Turn off the computer’s power, wait 20 seconds, then turn it on again. 
Unplug the CD-Writer Plus drive and plug it in again. (This is called 
cycling power.)
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1-10 If You Have Problems

■ Disconnect all the cables, look for and straighten any pins, and then 
reconnect the cables. Sometimes just reconnecting a cable aligns it 
correctly or adjusts the pin connections, fixing a faulty connection.

■ Check the list of known compatibility problems (on page 3-7) and in 
the Readme file.

■ Make sure that there is no switch box anywhere in the CD-Writer Plus 
drive’s cabling configuration.

■ If you have a printer connected to the CD-Writer Plus drive, check to 
see if your computer can detect the CD-Writer Plus drive when the 
printer is disconnected.

■ Check to make sure that your parallel port is truly configured as either 
EPP or ECP. Check the manual that came with your computer to find 
out how.

Check for a conflict with the parallel port (some other device 
using the same IRQ or I/O as the parallel port).

In Windows 95 or Windows 98, to find out if there is a conflict:
- Right-click on the My Computer icon
- Select Properties 
- Select the Device Manager tab:
  Under the heading SCSI Controllers, find Shuttle EPAT
  External ATAPI Adapter, and select Properties
    AND
  Under the heading Ports,  find Printer Port, and select
  Properties

  If you see a yellow exclamation mark to the left of this line,
  you do have a conflict. Determine which other device is
  using the same settings as your parallel port and change
  the settings on the other device.

If you discover you do have a conflict, to find out which device is in 
conflict:

■ In Windows 95 or Windows 98, right-click on the My Computer icon, 
select Properties, select the Device Manager tab, double-click on the 
computer icon to see a list of which device is using each resource 
setting on your computer.

Error message when I double-click on the CD-Writer Plus 
drive’s icon

■ There is no CD in the CD-Writer Plus drive; insert a CD and try again.
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■ After inserting a CD, you need to wait a moment to let the CD-Writer 
Plus drive read the disc information (wait until the light on the front 
of the drive stops flashing and stays green), then click on the CD-
Writer Plus drive’s icon again.

■ The CD may be in the tray upside-down or a little off-center; try 
reinserting the CD. The label should be facing up.

■ You are trying to read from a blank recordable CD. Try again after 
copying some information to the CD.

In Windows Explorer, unable to see the CD label or all the 
sessions/files on the CD 

Refresh the screen. Select the My Computer icon in Windows Explorer 
and press F5.

Printer no longer works after connecting the CD-Writer Plus 
drive 

Problems printing a file

■ See “Check for a conflict with the parallel port (some other device using the 
same IRQ or I/O as the parallel port).” on page 1-10. For example, a 
sound board or fax/modem board may be using the same IRQ. If you 
discover conflicts, change the IRQ setting on the other device. Refer 
to the manuals that came with your computer and other devices for 
instructions.

■ If your printer is attached to the CD-Writer Plus drive, printing 
documents while using the rewritable CD drive (for example, playing 
audio CDs, writing to disc) will yield unpredictable results and is not 
a supported function. This is because the printer and CD-Writer Plus 
drive are sharing the same data cable.

System does not recognize the CD-Writer Plus drive

■ In Windows 95 or Windows 98 simply click on the Connect or 
Disconnect external drive icon on your desktop. 

Select Shuttle EPAT External ATAPI Adapter, then click Disconnect.

Restart your computer, or shut it down and then turn it on again. 
Watch for the green light on the front of the CD-Writer Plus drive to 
blink as the computer boots up

Select Shuttle EPAT External ATAPI Adapter, then click Connect.
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1-12 Uninstalling the Software Programs

■ Make sure the CD-Writer Plus drive’s cables are connected properly.

■ See “Check for a conflict with the parallel port (some other device using the 
same IRQ or I/O as the parallel port).” on page 1-10. For example, a 
sound board or fax/modem board may be using the same IRQ. If you 
discover a conflict(s), change the setting on the other device. Refer to 
the manuals that came with your computer and other devices for 
instructions.

■ The power supply should have a steady green light when connected 
at both ends. If it is flashing, try a different power outlet. If it is still 
flashing the power supply could be damaged.

Uninstalling the Software Programs
You can remove all of CD-Writer Plus’s programs or individual programs.

CAUTION:  If you want to reinstall the CD-Writer Plus drive’s software, first be 
sure to uninstall the original software. 

1. Click the Start button.

■ Point to Programs.

■ Point to HP CD-Writer Plus.

■ Point to Tools & Information.

■ Point to Utilities.

■ Click Uninstall.

2. Select the CD-Writer Plus drive’s program(s) that you wish to remove.

3. Click the Finish button.

The software is removed, including all related entries in your system 
registry.
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Moving CD-Writer Plus to Another 
Computer

CAUTION:  The CD-Writer Plus contains sensitive, high-precision optical 
equipment. Dropping or shaking the CD-Writer Plus may cause damage to 
these sensitive components. Please be careful when handling your drive.

You can disconnect the CD-Writer Plus drive and move it to another 
computer, as long as the other computer meets the “Minimum System 
Requirements” on page A-1.

The CD-Writer Plus drive can be used by only one computer at a time. Do 
not try to use the CD-Writer Plus drive on more than one machine by 
attaching it to a switch box.

To disconnect the CD-Writer Plus drive:

1. In Windows NT, go to step 2.

In Windows 95 or Windows 98, click on the Connect or Disconnect 
external drive icon on the desktop.  

Select Shuttle EPAT External ATAPI Adapter, then click Disconnect.

2. Unplug the CD-Writer Plus’s power supply from the outlet or power strip. 
(The power plug and outlet may look different in your country.)

NOTE:  There is no power switch on the CD-Writer Plus drive or power supply. 
You may safely unplug the power supply without damage to the CD-Writer Plus 
drive.

Power supply
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1-14 Moving CD-Writer Plus to Another Computer

3. Disconnect the CD-Writer Plus data cable and audio cable (if any) from 
the back of the computer.

4. Disconnect the printer cable (if any) 
from your CD-Writer Plus drive and 
reconnect it to the printer port on the 
back of your computer (other cables 
not shown but still attached).

5. You are ready to connect the CD-
Writer Plus drive to another computer. 

To connect the CD-Writer Plus drive to another computer:

1. Follow the directions for “Connecting CD-Writer” on page 1-2.

2. The first time you attach the CD-Writer Plus drive to this computer, 
follow the directions in “Installing the Software for Windows 95/98, or 
Windows NT 4.0” on page 1-8.

Data cable
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Each additional time, after connecting all the cables:

■ In Windows NT, reboot your computer.

■ In Windows 95 or Windows 98, simply click on the Connect or 
Disconnect external drive icon on your desktop.  

Select Shuttle EPAT External ATAPI Adapter, then click Connect.
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Chapter 2:
Using Your CD-Writer 
Plus

This chapter describes how to use, purchase, and care for CDs; how to 
take care of your drive; and how to find out its drive letter.

Using CDs

Inserting a CD

1. Press the eject button on the CD-Writer Plus front panel.

2. Set the CD in the tray with the labeled side up.

Eject button
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3. Press the eject button again or push gently on the front of the tray to 
shut the tray.

When you access the CD-Writer Plus drive from within a program, you 
should be able to read the files on the inserted CD. If you have problems: 

■ The CD may be in the tray upside-down or a little off-center; try 
reinserting the CD. The label should be facing up.

■ After inserting a CD, you need to wait a moment to let the CD-Writer 
Plus drive read the disc information (wait until the light on the front 
of the drive stops flashing and stays green), then click on the CD-
Writer Plus drive’s icon again.

■ Are you trying to read from a blank recordable CD? Try again after 
copying some information to the CD.

Removing a CD

1. Press the eject button on the CD-Writer Plus front panel.

2. Remove the CD from the tray.

3. Press the eject button again or push gently on the front of the tray to 
shut the front panel.

Choosing CDs for Your CD-Writer

For best results, use Hewlett-Packard CD-RW (ReWritable) or CD-R 
(Recordable or write-once) media, available from your local vendor.

When to Use CD-RW

Ideas for using CD-RW (ReWritable) discs which can only be used in CD-
ReWritable drives or newer MultiRead CD-ROMs:

■ Use as if it were a large-capacity floppy disk

■ Copy your important files each week

■ Free up disk space on your hard drive

■ Transport files to and from work/home

■ Create personalized presentations
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■ E-mail storage

For information on sharing CD-RW discs with others, see “Using CD-RW 
Discs” on page 4-1.

When to Use CD-R

Ideas for using CD-R (Recordable or write-once) discs which can be read 
in most CD-ROM or CD-Recordable drives:

■ Permanently save large project files

■ Share non-editable presentations

■ Permanently store home records

■ Share memories with family and friends

■ Copy your music onto CD for personal use

■ Permanently archive files

Purchase HP CD-RW (ReWritable) media

Available from your local vendor, these CDs can be recorded or read in 
CD-ReWritable drives and read in newer MultiRead CD-ROMs.

Purchase HP CD-R (Recordable or write-once) media

Available from your local vendor, these CDs can be read by most CD-
ROM, CD-Recordable, and CD-ReWritable drives. (Use this type of media 
if you want to listen to your music CDs in a stereo.)

CD Care and Other Tips

■ Protect recording surfaces from scratches, fingerprints, and dirt.

■ Hold CDs by the outer edge or by the center hole.

■ You can clean a CD with a soft, dry cloth. Commercial CD cleaner or 
ethyl alcohol can also be used

■ Write by hand only on the “white” premarked label side using an oil 
based felt tip marker. Do not use a ballpoint pen.

■ Do not leave a CD in direct sunlight or in a hot, humid location.

■ If you lose power while writing to your CD (the CD-Writer Plus drive's 
red light is on) OR if you exit an application or press CTRL-ALT-DEL 
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while writing to CD, you may be able to salvage your CD, but ONLY if 
you: 

1. LEAVE YOUR CD IN THE DRIVE, DO NOT OPEN THE CD TRAY
2. Turn your machine off
3. Turn it back on
4. Then re-enter the application you were using 

Once the application tries to access the CD-Writer Plus drive, the 
recovery operation will make it appear that the last session is there. 
However, in reality, only a part of the CD's directory may be there. Your 
recordable CD is still usable if you can read the directory. Repeat the 
entire copy operation to make sure that your files are copied to the 
recordable or ReWritable CD.

■ Do not mix audio and data files on the same CD, since they require 
different formats, unless you are creating Mixed Mode or CD-Extra 
CDs. For more information on Mixed Mode and CD-Extra CDs, see 
the Easy-CD Creator online help.

Maintenance
The CD-Writer Plus drive requires no maintenance or cleaning. If you 
simply keep your CDs clean, you will prevent most problems. 

CAUTION: DO NOT use the CD-ROM cleaning CDs that rely on a small brush 
to sweep dirt off the laser. DO NOT use high-pressure air to clean the inside of 
the drive. These cleaning techniques will damage the CD-Writer Plus drive.

Identifying CD-Writer Plus’s Drive Letter
Not sure which drive letter was assigned to the CD-Writer Plus 
drive?

The CD-Writer Plus drive has a drive icon just like a CD-ROM drive icon. 
You can determine which icon is your CD-ROM drive and which icon is 
your CD-Writer Plus drive by double-clicking on the My Computer icon, 
right-clicking on the CD drive icon, and selecting Eject. 
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Chapter 3:
Problem Solving

Read this section if you run into trouble with your CD-Writer Plus drive. 
If after reviewing the section you need further assistance, call the phone 
numbers listed in “Appendix B:  Customer Support”

Gather the information on page B-1 before calling for help. Having this 
information ready will greatly facilitate your call.

Things to Try First
■ Does your computer meet the minimum system requirements 

(see“Minimum System Requirements” on page A-1 )?

■ Make sure your computer and CD-Writer Plus drive are plugged in 
and that each device attached to your computer is turned on.

■ Turn off the computer’s power, unplug the CD-Writer Plus drive, and 
wait 20 seconds.  Then plug in the CD-Writer Plus drive and turn on 
your computer. (This is called cycling power.)

■ Disconnect all the cables and then reconnect them. Sometimes just 
reconnecting a cable aligns it correctly or adjusts the pin connections, 
fixing a faulty connection. (Check for bent pins on the connectors 
and straighten them.)

■ Make sure that you are using the right type of CD. See “Choosing CDs 
for Your CD-Writer” on page 2-2.

■ Try the operation with a different CD.

■ Check the list of known compatibility problems (page 3-7) and in the 
Readme file.
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■ If your computer has a power-management feature, disable it (see the 
manual that came with your computer).

■ If your system is running printer status monitor software, disable it 
(page 3-7).

■ Make sure that you are not attaching a parallel port switch box 
anywhere in the CD-Writer Plus drive’s cabling configuration.

Common Symptoms and Solutions
■ Not sure which drive letter was assigned to the CD-Writer Plus drive? 

(See “Identifying CD-Writer Plus’s Drive Letter” on page 2-4.)

■ Error message when I double-click on the CD-Writer Plus drive’s icon 
(see page 1-10)

■ In Windows Explorer, unable to see the CD label or all the sessions/
files on the CD (see page 1-11)

■ Printer no longer works after connecting the CD-Writer Plus drive (see 
page 1-11)

■ Problems printing a file (see page 1-11)

■ System does not recognize the CD-Writer Plus drive (see page 1-11)

■ Copying directly from one CD to another doesn’t work. (see page 3-3)

■ Audio sounds poor (see page 3-3)

■ Video is choppy (see page 3-4)

■ Buffer underrun error messages (see page 3-4)

■ Unable to read a second session reading from a CD-ROM drive (see 
page 3-5)

■ Applications cannot find your CD in the CD-Writer Plus drive (see 
page 3-6)

■ Lost power to your computer or had to press CTRL-ALT-DEL while 
writing to the CD! (see page 3-6)

■ Hard Drive Compression Software (see page 3-7)

■ Achieving optimal performance (see page 3-7)

■ Printer Status Monitor Software (see page 3-7)
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■ Known Compatibility Problems (see page 3-7)

■ Finding the CD-Writer Plus driver files. (see page 3-8)

Copying directly from one CD to another doesn’t work.

WARNING: Only reproduce material for which you own the copyright or have 
obtained permission to copy from the copyright owner.  Unless you own the 
copyright or have permission to copy from the copyright owner, you may be 
violating copyright law and be subject to payment of damages and other 
remedies.  If you are uncertain about your rights, contact your legal advisor.

■ Some CD-ROMs will not allow direct copying to the CD-Writer Plus 
drive or are not capable of digital audio extraction.

■ You must have either a SCSI 2 CD-ROM drive (see the drive’s guide for 
information) or a supported ATAPI CD-ROM drive as your source.

■ Some CDs have a copy prevention feature or other features that do 
not allow a CD-to-CD copy.

Audio sounds poor

■ If your printer is attached to the CD-Writer Plus drive, printing 
documents while playing audio CDs will yield unpredictable results 
and is not a supported CD-Writer Plus drive function. This is because 
the printer and CD-Writer Plus drive are sharing the same data cable.

■ Make sure the audio connectors are completely plugged in to the back 
of the CD-Writer Plus drive and the LINE IN connector of the sound 
card on the back of the computer. (Your sound board may be labeled 
differently.) 

■ Verify that you do not have a sound-muting feature turned on, by 
way of the monitor or software.

■ Check the sound coming from the CD-Writer Plus drive by plugging 
earphones or speakers to the audio connector on the front of the CD-
Writer Plus drive. If the sound quality is good, the problem is 
probably with the sound board, speakers, or audio cable. Refer to the 
documentation that came with your sound board and speakers for 
help. If you are not already doing so, try using the audio cable that 
came with the CD-Writer Plus drive.

■ Try listening to the wave files on your hard drive to see if they 
sounded poor before copying them to CD.  (You can use the Media 
Player program found under Multimedia in Windows’ Accessories.)
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Video is choppy

This can be caused by the same situations that cause buffer underruns. 
This can also happen if your video card is slow. Try the following:

■ Try the solutions for buffer underruns (page 3-4).

■ Reduce the size of the video window and close any other programs 
that are running.

■ If the previous suggestions don’t work you may want to consider 
upgrading your video card.

Buffer underrun error messages

CD recordable devices require an uninterrupted data stream from the 
hard drive in order to write successfully to a CD. A buffer underrun 
message appears when for some reason the data stream is interrupted. 
This can occur, for example, if another application interrupts the writing 
process, or if the CD-Writer Plus drive’s write speed is set too high for the 
speed at which the hard drive can accesses and transfer data.

When using Easy-CD Creator or CD Copier:

■ Make sure you use the Test option in the software to ensure that the 
write speed is appropriate for your computer. For more information 
see the application’s online help.

■ Make sure your system meets the minimum system requirements 
(page A-1).

■ Buffer underrun may be caused by hard drive compression software 
(page 3-7). 

■ NEVER write to the recordable CD while other applications are 
running that could interrupt the writing-to-CD process. Log off any 
networks, disable any fax modem, email, screen saver, or other 
programs (such as TSRs, terminate-and-stay-resident programs) that 
may automatically send messages to your computer while writing 
data to the CD. If the interruption is long enough, you could ruin a 
write-once CD to which you are writing.

■ Exit any other programs while writing data to the CD.

■ If your computer has a power-management feature, disable it (see the 
manual that came with your computer).

■ Run SCANDISK.EXE and DEFRAG.EXE periodically on your hard 
drive (see your Windows manual for more information). These 
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programs improve access times to the hard drive, which will help 
improve system performance while writing to and reading from the 
CD-Writer Plus drive.

■ A small number of older hard drives are designed with a built-in 
interrupt loop that may cause a buffer underrun. If you are unable to 
resolve buffer underruns by any other means, contact your hard drive 
manufacturer to find out if this is the case for your hard drive.

Buffer underruns could also be caused by an unsupported parallel port 
(standard mode SPP).  See “Minimum System Requirements” on page A-
1. Try the following:

■ Write data to the CD at 1x speed if you are given the choice within 
the software.

■ Disable any printer status monitor software (page 3-7).

■ Change the parallel port settings to EPP or ECP in CMOS, if your 
computer can support the change. See the manual that came with 
your computer to find out how.

■ If the previous suggestions don’t work you may want to consider 
installing a new EPP or ECP parallel port card.

Unable to read a second session reading from a CD-ROM drive

■ Eject the CD and reinsert it.

■ Refresh the screen. Select the My Computer icon in Windows 
Explorer and press F5.

■ CD-RW (ReWritable) discs can only be used in CD-ReWritable drives 
or newer MultiRead CD-ROMs.

■ If you are trying to read your CD from Windows 3.x: Multi-session CDs 
created with Direct CD cannot be read in DOS or Windows 3.x. If 
your multi-session CD was created using some other program, verify 
that you are using version 2.23 of the MSCDEX.EXE file. First, restart 
your computer and when you see “Starting MS-DOS...” appear on 
your monitor, press F8. Each line in your CONFIG.SYS and 
AUTOEXEC.BAT file will load one at a time. Press “Y” until you see a 
line containing “MSCDEX.EXE”. Then press “Y” and the version 
number of your MSCDEX file will display. The number must be 2.23 
or greater. Call Microsoft for an updated file if you need it.

■ See if the CD-Writer Plus drive or other CD-ROM drives can read the 
CD. If so, the problem is probably with the CD-ROM drive. Contact 
the manufacturer of this drive for updated drivers. 
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Applications cannot find your CD in the CD-Writer Plus drive

Some programs (CD-ROM games, etc.) look only for the first logical drive 
letter assigned to a CD-ROM drive or CD-Writer Plus drive. For example, 
if your CD-ROM drive is assigned drive D:\ and the CD-Writer Plus drive 
is assigned drive E:\, the program is looking for the CD only in drive D:\ 
and will not see the CD in drive E:\. If you want to use the CD-Writer 
Plus drive for these types of programs, reassign the drive letters, making 
the CD-Writer Plus drive come before the CD-ROM drive, as follows:

■ In Windows 95 or Windows 98, display the Device Manager and  
double-click on CDROM. Double-click on the CD-ROM drive, and 
then click on the Settings tab. Under Reserved drive letters, select the 
drive letter after the existing letter (for both start and end drive letter) 
and click on OK. Then double-click on the CD-Writer Plus drive, and 
then click on the Settings tab. Under Reserved drive letters, select the 
drive letter before the current one and click on OK.

■ In Windows NT, click on Start/Programs/Administrative 
Tools(common). Choose Disk Administrator. Right-click on the 
drive letter you wish to change. Select Assign Drive Letter. Change 
the drive letter.

Lost power to your computer or had to press CTRL-ALT-DEL 
while writing to the CD!

If you lose power while writing to your CD (the CD-Writer Plus drive's 
red light is on) OR If you exit an application or press CTRL-ALT-DEL 
while writing to CD...

You may be able to salvage your CD, but ONLY if you: 

1. LEAVE YOUR CD IN THE DRIVE, DO NOT OPEN THE DISC TRAY
2. Turn your machine off
3. Turn it back on
4. Then re-enter the application you were using 

Once the application tries to access the CD-Writer Plus drive, the 
recovery operation will make it appear that the last session is there. 
However, in reality, only a part of the CD's directory may be there. Your 
recordable CD is still usable if you can read the directory. Repeat the 
entire copy operation to make sure that your files are copied to the 
recordable or ReWritable CD.
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Hard Drive Compression Software

We do not recommend using hard drive compression software. If you use 
hard drive compression software, it estimates free hard drive space based 
upon a compression ratio (often user selectable). Programs may check 
your hard drive for space needed and may think you have the necessary 
free space. However, depending on the type of files you are copying, you 
may in fact not have enough hard drive space.

Achieving optimal performance

Run SCANDISK.EXE and DEFRAG.EXE on your hard drive before using 
your CD-Writer Plus drive for the first time (see your Windows manual 
for more information). Then run them periodically after that. These 
programs improve access times to the hard drive, which will help 
improve system performance while writing to and reading from the CD-
Writer Plus drive.

Printer Status Monitor Software

NOTE: This is only an issue if your printer is connected to the back of the CD-
Writer Plus drive.

If your printer came with a program that notifies you about the status of 
the printer (such as when it is out of paper), this printer status monitor 
software might cause problems. The printer status monitor software checks 
the status of your printer every few seconds. If this happens while you are 
writing data to your recordable CD, it will cause data corruption. Turn off 
the printer status monitor software to prevent this problem. Check the 
information that came with your printer to find out how to do this.

Known Compatibility Problems 

■ Check the Readme file that came with the CD-Writer Plus drive for 
additional information. Click on Start, then point to Programs, HP 
CD-Writer Plus, Tools and Information, User Reference then click 
README.TXT. 

■ Check the HP web site listed on page B-4 for the most recent 
information.

■ Printers in General
If your printer came with a program that notifies you about the status 
of the printer (such as when it is out of paper), this printer status 
monitor software might cause problems. The printer status monitor 
software checks the status of your printer every few seconds. If this 
happens while you are writing data to your recordable CD with the 
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Easy-CD Audio or CD Copier software, it will cause data corruption. 
Turn off the printer status monitor software to prevent this problem. 
Check the information that came with your printer to find out how 
to do this.

Finding the CD-Writer Plus driver files. 

■ In Window 95/98, the following file is needed for your CD-Writer Plus 
drive to work successfully attached to a parallel port:
EPATAP9X.MPD (mini port driver file)

This file will be copied from Software Disc 1 during installation and 
located in the \WINDOWS\SYSTEM\IOSUBSYS\ directory.

■ In Window NT, the following files are needed for your CD-Writer Plus 
drive to work successfully attached to a parallel port: 
EPATAPNT.MPD (mini port driver file) 
SHARSHTL.SYS (printer driver support file)

These files will be copied from Software Disc 1 during installation and 
located in the \WINNT\SYSTEM32\DRIVERS\ directory.
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Chapter 4:
Sharing Your CDs

How you write your data to CD and the type of CDs that you use will 
determine who else can read the data from your discs. This chapter 
briefly explains some of the options you have in creating CDs that can be 
shared with others using different computer and CD setups.

Varying Formats
CD technology has progressed rapidly over the last few years from CD-
ROM to writable CD, and on to the technology you now own in your 
rewritable CD-Writer Plus. One of the results of these developments is 
that data can be written in several formats and on different types of CDs. 

Sharing CDs across Different Formats

Using CD-RW Discs

When should I use CD-RW discs?

CD-RW media is the ideal solution if you need more storage space on 
your computer. Your CD-Writer Plus drive, coupled with CD-RW media, 
can function as an extension of your hard drive.You can write, erase, and 
rewrite data easily from applications and from the Windows Explorer. 
Use CD-RW media:

■ To save work in progress like presentations, documents, etc.

■ Make weekly archives of files on your hard drive.

■ Shuttle files between the office and home if you have a CD-Writer 
Plus at each location, or have an external CD-Writer Plus to use on 
both computers.
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Can I share a CD-RW disc?

Yes. You can share a CD-RW disc directly with someone owning another 
CD-RW drive or with someone that has a MultiRead CD-ROM drive and 
UDF reader software. MultiRead CD-ROM drives are a recent innovation 
to CD-ROM technology, so while not all CD-ROMs are MultiRead, they 
are available to users world wide.

Can I make a diskette with UDF reader software for someone 
that has a MultiRead CD-ROM? 

The instructions below will show you how to copy the Adaptec DirectCD 
(UDF) Reader onto a diskette. When you have finished you will be able to 
install the UDF reader onto computers with MultiRead CD-ROMs where 
you want to read your CD-RW discs. 

To copy the Adaptec DirectCD (UDF) Reader to a diskette:

1. Insert “Software Disc 1” into the CD-ROM drive. A menu will appear.

2. From the menu, click Explore the CD. 

3. Double-click the CopyDisk folder and then double-click Copydisk. 

4. Select the Adaptec DirectCD Reader option and follow the instructions. 

How do I know if a CD-ROM is MultiRead?

Look for the MultiRead certification logo on the CD-ROM’s packaging or 
users guide. The drive will be described as MultiRead certified or will list 
CD-RW as supported media. You can also put a CD-RW disc in your CD-
ROM and see if it can read it. 

What if I want to share with users that have standard CD-ROM 
drives? (In Windows 95, Windows 98, and Windows NT 4.0)

In general, you must copy your information to a CD-R disc to share it 
with users that have standard CD-ROM drives. To accomplish this: 

1. Insert your CD-RW disc in your CD-Writer Plus drive. 

2. Copy all the information from the CD-RW disc to a unique location on 
your hard drive.

3. Replace the CD-RW disc in your CD-Writer Plus with a blank CD-R disc.

4. Copy the information from your hard drive to the CD-R media using 
DirectCD.

Download from Www.Somanuals.com. All Manuals Search And Download.



Sharing CDs across Different Formats 4-3

C
h

ap
ter 4:  Sh

arin
g

 Yo
ur C

D
s

5. When you eject the disc, DirectCD prompts you to either leave the disc 
as it is, or organize the disc so it can be read in most standard CD-ROM 
drives. Select the option to organize the CD so it can be read in most 
standard CD-ROM drives.

 NOTE: For additional information on sharing CDs with Windows 3.x and 
DOS users, see “CD-R discs created with DirectCD.” on page 4-3.

Can I play an audio disc I made on a CD-RW disc in my car or 
home CD player?

Probably not. Most car and home CD players are not capable of reading 
information off of CD-RW media. You must record your audio on CD-R 
discs to play them on most conventional CD players. There are however 
some newly released auto and home CD players that can read the CD-RW 
media.

Using CD-R Discs

When should I use CD-R discs?

The data you put on a CD-R can’t be erased. Use CD-R discs:

■ When you want to protect your data so that it cannot be erased

■ If you want to share your CD with users that have standard CD-ROM 
drives

■ For audio CDs

Can I automatically share a CD-R with anyone?

Not necessarily. The software application you use will determine with 
whom you can easily share the CD.

CD-R discs created with DirectCD.

Use DirectCD when you want to create data CDs to use on your own 
computer. For instructions on how to use DirectCD go to “Making Data 
CDs to Use on Your Own Computer” on page 5-1.

When you eject the disc from the drive, DirectCD will prompt you to 
either leave the disc as it is so you can add more data later, or organize it 
so it can be read in most standard CD-ROM drives under Windows 95 or 
Windows NT 4.0 Service Pack 3. If you intend to share the disc with other 
users, then you must select the option to organize it so it can be read in 
most standard CD-ROMs.
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■ Windows 95, Windows 98, and Windows NT 4.0. Your CD-R 
organized to be read in most standard CD-ROMs is now ready to be 
shared with Windows 95, Windows 98, and Windows NT 4.0 users.

There may be some CD-ROMs that can’t read the CD-R. If you have 
problems try turning off the “Read Ahead” on your CD-ROM. Refer to 
your operating system documentation on how to do this. Another 
option is to use CD Copier to create a disc copy of your original CD-R 
disc. A description of how to do this can be found in the section 
“Making a Copy of a CD” on page 8-3.

■ Windows 3.x and DOS. Your CD-R organized to be read in most 
standard CD-ROMs under Windows 95 and Windows NT cannot 
automatically be read in Windows 3.x or DOS. Some additional steps 
are required if you want to share this disc with Windows 3.x or DOS 
users. You will need to create a copy of your original CD-R disc on 
another piece of CD-R media using the CD Copier application. This 
will write a disc in the proper format for Windows 3.x and DOS users. 
Follow the instructions given in the section “Making a Copy of a CD” 
on page 8-3 to accomplish this task.

NOTE: CDs created with CD Copier will display long filenames when viewed in 
Windows 95, 98, and NT. When viewed in Windows 3.x and DOS, file names 
are shortened to the DOS standard of eight characters with a three-character 
extension. Files and executables that expect a specific file name may not 
function as anticipated in Windows 3.x and DOS.

CD-R discs created with Easy-CD Creator (Audio). 

This application automatically writes the audio format understood by 
millions of car and home CD players in existence today. You will be able 
to share this disc with virtually any user. 

CD-R discs created with Easy-CD Creator (Data).

Use Easy-CD Creator (Data) when you want to create data CDs you can 
share with other users, for example if you want to send the CD to your 
co-workers. For instructions on how to use Easy-CD Creator (Data) go to 
“Making Data CDs to Use on Different Types of Computers” on page 5-6.

Easy-CD Creator is called a mastering application since, when used with 
CD-R media, it is capable of directly writing discs using a format that can 
be read by virtually all CD-ROM drives and operating systems 
(Windows95, Windows NT, Windows 3.x, and DOS). 
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Interchange Summary

The following table is a brief summary of which CD drives can read discs 
created with certain application/media combinations.

* Your CD-ROM drive must be capable of reading packet-written CDs. Most CD-ROM drives 
are packet tolerant. If you have problems, check your drive’s documentation or consult the 
drive’s manufacturer.

Application 
used to make 

a CD

Type of CD 
used

Drives that can read the CD

DirectCD CD-RW MultiRead CD-ROM with UDF 
reader
Windows 95, 98, and NT 4.0

CD-R
(closed)

*Most CD-ROMs 
Windows 95, 98, and NT 4.0

CD Copier CD-RW MultiRead CD-ROM

CD-R Any CD-ROM 

Easy-CD 
Creator
(Audio)

CD-RW MultiRead CD-ROM

CD-R Any CD-ROM, home or car CD 
player

Easy-CD 
Creator
(Data)

CD-RW MultiRead CD-ROM

CD-R Any CD-ROM

Download from Www.Somanuals.com. All Manuals Search And Download.



5-1

C
h

ap
ter 5:  M

akin
g

 D
ata C

D
s

Chapter 5:
Making Data CDs

You can make data CDs with DirectCD™ and with Easy CD Creator™. You 
can copy data to both CD-Recordable (CD-R) and CD-ReWritable 
(CD-RW) discs. DirectCD and Easy CD Creator make data CDs in a 
slightly different way for different purposes. The correct program is 
launched automatically when you decide what kind of data CD you want 
to make.

■ If you want to make a data CD to use on your own computer, follow 
the instructions in “Making Data CDs to Use on Your Own 
Computer” below.

■ If you want to make a data CD to use on your own computer or on 
different types of computers (for example, computers running under 
DOS or Windows 3.x) that do not have DirectCD, follow the 
instructions in “Making Data CDs to Use on Different Types of 
Computers” on page 5-6.

Making Data CDs to Use on Your Own 
Computer

DirectCD enables you to write files directly to a CD-Recordable (CD-R) or 
CD-ReWritable (CD-RW) disc, in much the same way you would write 
them to a floppy diskette or a removable media drive. This is especially 
handy for making data discs to use with your own computer. For 
example, you might want to

■ Archive data and then remove it from your hard drive

■ Back up the files on your hard drive
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■ Transfer a large number of files from the computer you use at work to 
the computer you use at home

NOTE: Other people may be able to read data discs you create with DirectCD 
on their computers if their CD-related hardware and software is set up the same 
as it is on your computer. However, it is more likely that your data discs will be 
usable on other computers if you create them with Easy CD Creator, as 
described in “Making Data CDs to Use on Different Types of Computers” on 
page 5-6.

DirectCD lets you read and write files directly to your CD with any 
software application that can read from and write to a drive letter. Some 
examples include:

■ Software applications such as Microsoft Word, when you use the 
Save or Save As commands

■ Windows Explorer, when you drag and drop files

■ Windows 95®, Windows 98/NT, when you use the Send To 
command

■ MS-DOS, when you use command prompts from within 
Windows 95/NT

DirectCD provides a file system based on UDF v1.5 specifications and 
writes data to the CD-R or CD-RW disc using packet-writing technology. 
This technology, together with the file system, gives you drive letter 
access to your CD-Writer Plus. A DirectCD wizard guides you step-by-step 
through the process of preparing and ejecting CD-R and CD-RW discs.

Preparing a Data CD

Follow these steps to start DirectCD and prepare a blank CD-R or CD-RW 
disc for reading and writing data. (If you want to write more data to a 
disc that you already formatted in DirectCD, see “Writing More Data to a 
DirectCD Disc” on page 5-5.)

1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.” (If the DirectCD Disc Ready window appears, the 
disc has already been prepared, and you can start writing data to it.)
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NOTE: If no screen appears after about 15 seconds, the disc may not be blank, 
or it may have an unreadable format. (See “Fixing an Unreadable Disc” on 
page 5-6 for more information.) Or the “Auto insert notification” option may be 
disabled (this applies to Windows 95 only). To check this, click Start, move the 
mouse pointer over Settings, and click Control Panel. In Control Panel, 
double-click System and select the Device Manager tab. Double-click the 
CD-Writer Plus icon, then select the Settings tab. Click Auto insert 
notification if it does not have a check mark next to it, and click OK. Click 
OK on the System Properties dialog box. Then close the Control Panel.

3. Select the first option: Click here to create a data CD that will be 
accessible through a drive letter, i.e. as you would use a floppy drive. 
The Format Disc screen appears. If you are formatting a CD-R disc, 
continue with the next step. If you are formatting a CD-RW disc, skip to 
step #5.

4. If you are formatting a CD-R disc, click Next on the Format Disc screen 
and skip to step #6.

5. If you are formatting a CD-RW disc, you can choose between two 
formatting options. To do this, click the Advanced button that appears 
on the Format Disc screen. When the next screen appears, select either 
Fast Format or Full Format and click OK.

We recommend that you select HP fast format, which lets you start 
writing to the CD-RW disc almost immediately while the disc is 
formatted in the background. A Full Format requires you to wait about 
an hour until the formatting is complete before you can write to the disc. 
Click the Help button for more information about the formatting 
options.

NOTE: Data is safe if you write it to the disc while HP fast format takes place 
in the background. HP fast format will NOT overwrite this data, because the 
data is written to sections of the disc that have already been formatted.

6. When the Name Your Disc screen appears, type a name for the disc and 
click Finish. Disc formatting begins.

When the DirectCD Disc Ready window appears, the formatting is 
complete.

NOTE: Formatted CD-RW discs have about 530 MB of available space, while 
formatted CD-R discs can store up to 618 MB of data.

7. Click OK.

The DirectCD disc is ready for you to write data to it.
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Writing Data to a DirectCD Disc

Once your CD is formatted as a DirectCD disc, you can write data to it in 
several different ways:

■ Drag and drop files from Windows Explorer onto the CD-Writer Plus 
icon.

■ Select Save As from a Windows 95 Windows 98/NT application File 
menu and select the drive letter of your CD-Writer Plus.

■ Use the Send To command.

■ Use MS-DOS command prompts from a DOS window in 
Windows 95/NT.

Ejecting a DirectCD Disc

DirectCD gives you various formatting options when you eject a 
DirectCD disc from the CD-Writer Plus. The options depend on what 
kind of disc DirectCD detects in the drive and how you want to use the 
disc. To eject a DirectCD disc, follow these steps:

1. Push the eject button on the front of the CD-Writer Plus, or

Right-click on the CD icon  on the taskbar and select Eject from the 
drop-down list box.

The Eject Disc screen appears.

2. Carefully read the text that appears on the screen and, if options are 
presented, select the option you want.

3. Click Finish to eject the disc from the CD-Writer Plus.

NOTE: If you are using a CD-RW disc, see “Chapter 4: Sharing Your CDs” for 
more information about making CDs readable on different types of computers.
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Writing More Data to a DirectCD Disc

If you previously formatted a blank disc for DirectCD use, you can add 
more data to the disc until it is full. To do so, follow these steps:

1. Insert the DirectCD disc into your CD-Writer Plus.

2. Wait for the DirectCD Disc Ready window to appear. (If the Make Disc 
Writable screen appears, simply follow the on-screen directions to make 
the disc writable.)

3. Click OK and continue writing more data to the disc.

Erasing a DirectCD Disc

If you are using CD-RW discs in your CD-Writer Plus, you can actually 
erase files from the disc and use the recovered space to write new files. 
However, if you “delete” files from a CD-R disc, the files become invisible 
to the file system (such as Windows Explorer) but the space they occupy 
is not made available for other files. Thus, “deleting” files from a CD-R 
disc will not increase the available free space on the disc.

To erase the contents on a DirectCD disc, follow these steps:

1. While in Windows Explorer, select the file(s) you want to erase.

2. Select Delete from the File menu.

3. Click Yes to confirm that you want to erase the files from the disc.

DirectCD erases the selected file(s) from the disc.
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Fixing an Unreadable Disc

If no window appears on the screen after about 15 seconds when you 
insert a disc in the CD-Writer Plus, the disc may have an unreadable 
format. DirectCD has a ScanDisc application that may be able to recover 
data on the disc and allow you to write to it and read from it again. 
Follow these steps to use ScanDisc:

1. Double-click the CD icon on the right side of the Windows taskbar. 
If the disc is unreadable, the ScanDisc window will appear.

2. Read the text in the window, then click the ScanDisc button.

3. Wait while ScanDisc repairs the disc. A message will appear on the screen 
when ScanDisc is finished.

NOTE: You can also start ScanDisc through the Start menu. To do this, click 
Start on the Windows taskbar. Move the mouse pointer over Programs, HP 
CD-Writer Plus, Tools and Information, and Utilities. Then select ScanDisc.

Making Data CDs to Use on Different 
Types of Computers

Adaptec Easy CD Creator enables you to write files directly to a 
CD-Recordable (CD-R) or CD-ReWritable* (CD-RW) disc in a format that 
can be read by different types of computers. This is handy if, for example, 
you want to create a CD for someone who has a computer running under 
DOS or Windows 3.x.

Follow these steps to start Easy CD Creator and copy data files to a blank 
CD-R or CD-RW disc:

1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.”

* CD-RW discs can only be read in a MultiRead CD-ROM drive or in another 
CD-RW drive.
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NOTE: If the screen does not appear after about 15 seconds, you may have 
inserted a disc that is already formatted. Remove the disc and insert a blank 
disc. Or the “Auto insert notification” option may be disabled (this applies to 
Windows 95 only). To check this, click Start, move the mouse pointer over 
Settings, and click Control Panel. In Control Panel, double-click System and 
select the Device Manager tab. Double-click the icon for the CD-Writer Plus, 
then select the Settings tab. Click Auto insert notification if it does not have 
a check mark next to it, and click OK. Click OK on the System Properties dialog 
box. Then close the Control Panel.

3. Select the second option: Click here to create a data CD for 
distribution among different types of computers. The Easy CD Creator 
Wizard appears.

4. Leave the Data CD radio button selected, and click Next.

5. When the next screen appears, select the files and folders you want to 
copy to the disc and click Add Now. The graph bar in the lower part of 
the screen indicates how much space is left on the disc.

6. When you are done adding files, click Next. The Test Before Writing 
window appears.

7. Click Next, then click Finish on the Ready to Create CD window to 
create the CD. The testing and copying process may take a long time if 
you are copying many folders and files.

8. When the testing and copying process is completed, eject the CD from 
the drive.

NOTE: These instructions describe the simplest, most direct way to create a 
data disc with Easy CD Creator. Other options are also available, such as re-
arranging the folder/file structure after you have selected the files to copy to the 
CD. See the Easy CD Creator online help for more information.

Download from Www.Somanuals.com. All Manuals Search And Download.



5-8 Getting Help

Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about Easy CD Creator and DirectCD, refer to the 
appropriate topics in the online Help. To access the online Help, select 
Help Topics from the Help menu of either program.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 6:
Making Music CDs

A music CD is a compact disc (CD) containing digital audio tracks 
recorded in the Compact Disc-Digital Audio (CD-DA) format.

Music CDs can store up to 74 minutes of music and may contain up to 99 
tracks, each usually representing a separate piece of music. Music CDs 
can be played back from a home or car CD player or from a CD-ROM 
drive through speakers or headphones attached to the drive’s output jack.

You can use Easy CD Creator to:

■ Compile audio CDs of your favorite music

■ Make CDs from Wave (.wav) files on your hard drive

Starting Easy CD Creator
1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.”

NOTE: If no screen appears after about 15 seconds, you may have inserted a 
disc that is already formatted. Remove the disc and insert a blank disc. Or the 
“Auto insert notification” option may be disabled (this applies to Windows 95 
only). To check this, click Start, move the mouse pointer over Settings, and 
click Control Panel. In Control Panel, double-click System and select the 
Device Manager tab. Double-click the icon for the CD-Writer Plus, then select 
the Settings tab. Click Auto insert notification if it does not have a check 
mark next to it, and click OK. Click OK on the System Properties dialog box. 
Then close the Control Panel.
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3. Select the third option: Click here to create an audio CD that will be 
playable in any CD player. The Adaptec Easy CD Creator Wizard 
window appears.

Making a Music CD
You can make a music CD by recording songs from:

■ Tracks on an existing CD

■ Wave files stored on your hard drive (*.wav is a standard Windows 
format for sound files.)

■ A combination of Wave files and tracks

This section explains how you can make a simple music CD with the 
Easy CD Creator Wizard. It also explains how to do other tasks like 
recording audio tracks from an existing music CD and recording Wave 
files stored on your hard drive.

NOTE: Easy CD Creator is designed to assist you in reproducing material in 
which you own the copyright or have obtained permission to copy from the 
copyright owner. Unless you own the copyright or have permission to copy from 
the copyright owner, you may be violating copyright law and be subject to 
payment of damages and other remedies. If you are uncertain about your rights, 
contact your legal advisor.
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Using the Wizard

The easiest way to make a music CD is to use the Easy CD Creator 
Wizard, which appears when you first start Easy CD Creator. The Wizard 
guides you step-by-step in making a simple music CD. Follow these steps 
to make a music CD with the Wizard:

1. Start Easy CD Creator if it is not already running (see “Starting 
Easy CD Creator” on page 6-1.) The Adaptec Easy CD Creator Wizard 
appears, as shown here:

2. Follow the on-screen instructions in the Wizard windows.

As you add tracks to write to the CD, a list of these tracks will appear in 
the main Easy CD Creator window at the bottom of the screen. A final 
message box notifies you when the recording is complete.

Recording Audio Tracks from an Existing 
Music CD

To record songs (audio tracks) from an existing music CD, you need to 
first create a CD layout— a file that contains the list of songs and the 
order in which they will be recorded—then record the layout to a blank 
CD. To do so, follow these steps:

1. Start Easy CD Creator, if it is not already running.
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2. Select New CD Layout from the File menu or open an existing CD 
layout. 

3. Click the Audio CD Layout tab:

The top part of the window is Windows Explorer, where you can select 
the songs you want to record. The bottom part is the Audio CD Layout 
window, which allows you to view the contents of the CD layout. To 
make changes to the list of tracks in the Audio CD Layout tab, see 
“Changing the Order of Your Songs” on page 6-8.

4. Insert the source CD, which contains the songs you want to record, in 
your CD-Writer Plus.

NOTE: You can record directly from a CD-ROM drive only if it supports digital 
audio extraction. See “Recording from a CD-ROM Drive” in the 
Easy CD Creator Online Help.

5. In the Windows Explorer section of the window, select the drive where 
the source CD is located to view the list of songs on the original CD.

6. Drag the songs that you want to record from Windows Explorer to the 
Audio CD Layout window. 

To change the name of a song, see “Renaming Songs in Your CD Layout” 
on page 6-8.

Windows Explorer Audio CD Layout Window
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7. Repeat steps 4, 5, and 6 for each existing music CD from which you want 
to record songs. 

8. Select Create CD from the File menu when you have placed all of the 
songs that you want to record into the Audio CD Layout window.

The CD Creation Setup box appears.

9. Make changes, if any, to the CD Creation Setup settings (see “CD 
Creation Setup Settings” in the Easy CD Creator Online Help for 
descriptions) and click OK.

Easy CD Creator needs a blank CD before it can begin recording your CD 
layout. Insert a blank CD when prompted. A final message box notifies 
you when the recording is complete.

NOTE: To make a jewel case insert that lists the artist, CD title, and songs, see 
“Chapter 7: Making Inserts and Labels”.

Recording Wave Files Stored on Your Hard 
Drive

To record a music CD using Wave files (*.wav), the Wave files must be 
stored on your hard drive at 11, 22, 44.1 KHz, 8- or 16-bit, mono or 
stereo. To make a Wave file from an existing CD, see “Pre-recording 
Audio Tracks to Wave Files” on page 6-6.

NOTE: For best results, record your .wav files at 44.1 KHz, 16-bit stereo. For 
more information, see the documentation for your Wave editor program.

To record Wave files stored on your hard drive to a blank CD, follow 
these steps:

1. Insert a blank CD in your CD-Writer Plus.

2. Select New CD Layout from the File menu, or open an existing layout.

3. Click the Audio CD Layout tab.

4. Select the Wave files you want to record from Explorer and drag them to 
the Audio CD Layout window.

5. To change the name of the song(s), see “Renaming Songs in Your CD 
Layout” on page 6-8.
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6. Select Create CD from the File menu when you have finished adding all 
of the songs you want to record to your CD layout. The CD Creation 
Setup box appears.

7. Make changes, if any, to the CD Creation Setup settings (see “CD 
Creation Setup Settings” in the Easy CD Creator Online Help for 
descriptions) and click OK.

Easy CD Creator will begin recording your CD layout to the blank CD. 
An on-screen message notifies you when the recording is complete.

NOTE: To make a jewel case insert that lists the artist, CD title, and songs, see 
“Chapter 7: Making Inserts and Labels.”

Pre-recording Audio Tracks to Wave Files

Pre-recording audio tracks to Wave files on your hard drive is a way to:

■ Minimize swapping CDs in and out of your drive if you want to make 
more than one copy, or if you have only a CD-Writer Plus drive

■ Add sound effects to customize any song on the CD (using a third-
party sound editor)

■ Improve the sound quality if your CD recording system is less than 
optimal

You can pre-record one Wave file at a time. To pre-record a Wave file from 
an existing CD, follow these steps:

1. Insert the source CD, which contains the song you want to pre-record to 
your hard drive, into your CD-Writer Plus.

2. Click the Audio CD Layout tab in Easy CD Creator.

3. Select the audio track you want to pre-record from Explorer and drag it 
into the Audio CD Layout window.

4. Highlight the audio track in the Audio CD Layout window.

5. Select Pre-record to WAV file from the Track menu.

NOTE: Pre-recording audio tracks to Wave files requires approximately 10MB 
of space on your hard drive for one minute of music.
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6. Type in a file name for the Wave file and choose a different location on 
your hard drive if you do not want to record your Wave file to your Temp 
directory.

7. Click Save.

Easy CD Creator pre-records your Wave file to your hard drive. An on-
screen message notifies you when the recording is complete.

Combining Both Audio Tracks and Wave Files

You can make a music CD that contains songs both from pre-recorded 
Wave files stored on your hard drive and from audio tracks on an existing 
music CD. To do so, follow the steps outlined in “Recording Audio Tracks 
from an Existing Music CD” on page 6-3 and “Recording Wave Files 
Stored on Your Hard Drive” on page 6-5, depending on the type of songs 
you want to record. When you have added all of the audio tracks and 
Wave files you want to record to your CD layout, select Create CD from 
the File menu.
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Modifying Your CD Layout
The following sections describe how to make changes to your CD layout.

Changing the Order of Your Songs

Once you have added more than one song to your CD layout, you can 
change the order of the songs at any time before creating the CD.

To change the order of the songs, follow these steps:

1. Select the song whose order you want to change in the CD layout.

2. Drag the song to the position where you want it to appear in the Audio 
CD Layout window.

Removing Songs from Your CD Layout

You can remove any song you have added to a CD layout at any time 
before you create a CD. To remove a song from your CD layout, follow 
these steps:

1. Select the song you want to remove in the Audio CD Layout window.

2. Select Cut from the Edit menu.

Renaming Songs in Your CD Layout

To rename a song listed in your CD Layout, follow these steps:

1. Select the song you want to rename in the Audio CD Layout window.

2. Select Rename in the Track menu.

3. Type the new name in the text box.
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Saving a CD Layout

You can create a CD layout, save it, then use it to record a CD later. To 
save a CD layout, follow these steps:

1. Select Save As from the File menu.

2. Type in the File name.

3. Select the location where you want to store the file.

Opening an Existing CD Layout

To open a CD layout you have previously saved:

■ Select Open CD Layout from the File menu. 

Easy CD Creator displays the contents of the layout.

Playing Music CDs
Use the Windows CD Player to listen to music CDs. To do this, follow 
these steps:

1. Insert the music CD in your computer’s CD-ROM drive.

2. Click the Start button on the Windows taskbar, then move the mouse 
pointer over Programs, Accessories, and Multimedia.

3. Select CD Player. The CD Player window appears.

4. Click the start button to start playing the music CD.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about Easy CD Creator, refer to the appropriate topics in 
the online Help. To access the Easy CD Creator online Help, select Help 
Topics from the Help menu.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 7:
Making Inserts and 
Labels

A jewel case insert is a cover you can print and insert in the CD’s jewel 
case—the plastic case that holds the CD—to display the title and contents 
of your CD.

The cover is printed on one side of a sheet of paper and then folded. One 
side lists the files or tracks; the other side shows the title and may also 
contain graphics.

Easy CD Creator allows you to customize your own jewel case insert. 
Once you have edited the jewel case insert, you can preview it, print it, 
cut it to size, and insert it in the case. You can also design and print a 
label for the top of the CD. You can print the label on a standard printer 
if you use special paper designed for disc labels.
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How to Make a Jewel Case Insert or a Label
When you make a music CD, Easy CD Creator uses the CD layout 
information to create a basic jewel case insert, including the CD title, 
artist name, and list of songs. You can then click the Jewel Case Layout 
tab to modify and customize that information, such as changing font 
styles and adding graphics. 

Creating custom jewel case inserts involves three basic tasks:

■ Editing inserts

■ Adding text and graphics

■ Printing

Creating CD labels involves the second and third steps; Easy CD Creator 
does not automatically create any text for the label. The following 
sections explain how to view and edit jewel case inserts and CD labels, 
add text and graphics, and print the inserts and labels.

Editing Inserts and Labels

The following sections describe the different ways you can view and edit 
jewel case inserts and labels before printing them.

Viewing Inserts and Labels

To view the different parts (pages) of the jewel case insert or CD label, 
follow these steps:

1. Click the Jewel Case Layout tab in Easy CD Creator.

2. From the Page menu, select the item you want to view:

■ Jewel Front—to view the Inside Jacket and Front Cover

■ Jewel Back—to view the Back Cover

■ Disc Printer—to view the Compact Disc label

Easy CD Creator displays the view.
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Zooming

To view a section of an insert page or label in greater detail, you can 
magnify the view. To change the magnification of the page, follow these 
steps:

1. Select Zoom from the Page menu.

2. Select the zoom level you want to apply.

3. Click OK.

Easy CD Creator changes the magnification level.

Using Rulers and Grids

You can use rulers and grids to position text and graphics on the jewel 
case insert or the label. See “Setting Insert Layout Options” in the 
Easy CD Creator online Help for more information on how to do this.

Using Rulers

Rulers are displayed along the perimeter of the Jewel Case Layout 
window and help you to measure the insert or label and its objects.

To display or hide the rulers, do the following:

■ Select the Ruler option from the View menu to view rulers.

■ Deselect the Ruler option from the View menu to hide rulers.
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Using Grids

Grids help you to more precisely position objects with respect to other 
objects on the insert or label.

To snap objects to a grid—meaning the objects are automatically moved 
to the grid line—do the following:

1. Select Grid from the Layout menu.

2. Select Snap to Grid from the Layout menu.

The objects snap to the nearest grid marker when you move them around 
on the page.

To display or hide the grids, do the following:

■ Select the Grid option from the Layout menu to view grids.

■ Deselect the Grid option from the Layout menu to hide grids.

Positioning Inserts

You can position the insert or CD label at any location on the physical 

page. For an approximate position, use the box at the intersection 
of the two rulers.

To position the insert or label, follow these steps:

■ Drag the box at the intersection of the ruler to the position on the 
page where you want the upper left corner of the insert or label to be 
located.

For more precise control over the position of the insert or label, use the 
Origin settings in the preferences. See “Setting Insert Layout Options” in 
the Easy CD Creator online Help.
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Adding Text

You can add as much text as you like to the jewel case insert or CD label. 
When you add text, you can define some attributes, such as font style, 
color, and background fill color. 

To add text, follow these steps:

1. Select Insert Text from the Edit menu. 

2. Type the text in the Text box.

3. Select the text attributes you want by clicking the Fill Color, Text Color, 
or Font buttons:

4. Click OK.

The text is added where the cursor is located on the Jewel Case Layout 
window.

Attribute Description

Fill Color Select the color you want surrounding the 
text.
NOTE: When text is marked Transparent—
meaning that you can see the background 
behind the text— you cannot define a fill 
color.

Text Color Select the color of the text.

Font Select the font, style, and size of the text.
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Editing Text Objects

To change the attributes of any text object, follow these steps:

1. Double-click the text object you want to edit.

2. Select the text attributes you want to change. (See “Adding Text” on page 
7-5.)

3. Click OK.

Adding Graphics

The graphics used in Easy CD Creator are called OLE objects. OLE is a 
Windows feature that maintains associations with objects across different 
applications. For example, if you add an OLE object to a jewel case insert 
or CD label, you can double-click the object to open the associated 
application so you can edit the object.

To create and insert an OLE object, follow these steps:

1. Select Insert and New Object from the Edit menu. A list of Object Types 
appears.

2. Select the Create New option to the left of the Object Types list.

Select Create From File instead if you want to import an existing graphics 
file—for example, a piece of computer “clip art.”

3. Select from the Object Type list the application you will use to create the 
graphic. For example, select Bitmap Image if you want to create a 
graphic with Windows Paintbrush.

4. Click OK.

5. Create (or select) the graphic. The way in which you do this depends on 
which application you selected. For example:

If you select Bitmap Image a small window will appear in the middle of 
the Jewel Case Layout window. Create the bitmap image in this window, 
using the Windows Paintbrush tools that appear on the screen. When 
you are finished, click outside the small window to “paste” the image 
into the jewel case insert or CD label.
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If you select Microsoft Clipart Gallery, you will see a window with small 
images of the available graphics. Select the graphic you want and click 
Insert.

6. Move or resize the graphic, as required.

NOTE: See the “Adding Graphics” topic in Easy CD Creator online Help for 
information on editing and moving objects.

Arranging Track Titles

Information about tracks listed in the Audio CD Layout is automatically 
added to the Jewel Case Layout window. If you delete tracks while 
making an audio CD, the associated information is automatically 
updated in the Jewel Case Layout tab.

Deleting tracks while preparing to make an audio CD may cause blank 
rows to appear in the tracks list of the Jewel Case Layout tab. Therefore, if 
you make changes to the track list that affect the position of the tracks 
on the Jewel Case Layout window, Easy CD Creator asks if you want the 
tracks automatically repositioned.

The Jewel Case Layout tab provides some commands that let you create 
columns of track information, display the length and number of each 
track, and automatically position tracks on the layout.

The following sections describe different ways you can arrange the tracks 
in the Jewel Case Layout.

Creating Track Column Lists

You can arrange the track information boxes:

■ Randomly by dragging them to new positions in the Jewel Case 
Layout window, or 

■ In a linear list with one or two columns.

To create a track list:

■ Select One Column or Two Column from the Text menu.
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Displaying Track Numbers and Duration Times

Easy CD Creator includes the track number and duration time for each 
audio track. The track number indicates the order in which the audio 
tracks are recorded. The duration time is shown in minutes and seconds.

To display the track numbers:

■ Select Display Track Number from the Text menu.

To display track duration times:

■ Select Display Track Time from the Text menu.

Fitting Tracks on a Page

Fitting tracks means all the track information is centered on each page 
and aligned along the first character of each track.

You can move track titles from the inside jacket and the back cover to the 
front cover. However, Best Fit will move tracks back to their original 
location.

To fit the tracks on the page as described above:

■ Select Best Fit from the Arrange menu.

Printing Jewel Case Inserts and CD Labels

You can print a jewel case insert or a CD label while the Jewel Case 
Layout tab is open. The commands and options available for printing 
depend on the type of printer connected to your computer. For 
information about these options, see your printer’s guide.

To print a jewel case insert or a disc label, follow these steps:

1. Select Print from the File menu.

2. Click OK.

To preview an insert or label before printing it:

1. Select Print Preview from the File menu.

2. Click OK.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about Easy CD Creator, refer to the appropriate topics in 
the online Help. To access the Easy CD Creator online Help, select Help 
Topics from the Help menu.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 8:
Copying CDs

CD Copier is a convenient tool for making copies of your CDs. The most 
common reason for making a copy of a CD is to create a working copy of 
a CD and archive the original in a safe place.

NOTE: CD Copier is designed to assist you in reproducing material in which 
you own the copyright or have obtained permission to copy from the copyright 
owner. Unless you own the copyright or have permission to copy from the 
copyright owner, you may be violating copyright law and be subject to payment 
of damages and other remedies. If you are uncertain about your rights, contact 
your legal advisor.

What Types of CDs Can I Copy?
You can use CD Copier to make backup copies of almost any type of CD. 
The following table lists the types of CDs that can be copied and includes 
some notes about making backup copies:

Type of CD Notes

Audio or 
CD Extra

If you are using a drive other than a CD-Writer Plus, 
you need a source CD-ROM drive capable of reading 
audio digitally. Not all drives support digital audio 
extraction. See “Testing Your System Configuration” in 
the CD Copier online help. (CD Copier tests your drive 
to determine its capabilities when the source CD is 
inserted.)

NOTE: CD Copier supports copying CDs in Track-at-Once 
mode. This means that there will be two seconds of silence 
between tracks.
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Starting CD Copier
Follow these steps to start CD Copier:

1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.”

NOTE: If no screen appears after about 15 seconds, you may have inserted a 
disc that is already formatted. Remove the disc and insert a blank disc. Or the 
“Auto insert notification” option may be disabled (this applies to Windows 95 
and Windows 98 only). To check this, click Start, move the mouse pointer over 
Settings, and click Control Panel. In Control Panel, double-click System and 
select the Device Manager tab. Double-click the icon for the CD-Writer Plus, 
then select the Settings tab. Click Auto insert notification if it does not have 
a check mark next to it, and click OK. Click OK on the System Properties dialog 
box. Then close the Control Panel.

Data CD Some CD-ROM drives may not be able to read a 
DirectCD data disc. If you have a true MultiRead 
CD-ROM drive, there should be no problems.

Mixed-Mode Mixed results. Some CDs copy perfectly; others do not, 
possibly because the CD is formatted to circumvent 
copying or because some CDs do not follow the 
standard specifications.

Photo CD Requires a source CD-ROM drive that can read 
CD-ROM XA. Most current drives support this.

Video CD Requires a source CD-ROM drive that can read 
CD-ROM XA. Most current drives support this.

Type of CD Notes
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3. Select Click here to create a duplicate of an existing audio CD or data 
CD. The CD Copier Source and Destination tab appears.

NOTE: You can also start CD Copier by clicking the Windows Start button 
(located on the left side of the taskbar), selecting Programs, pointing to HP 
CD-Writer Plus, and selecting Copy CDs.

Making a Copy of a CD
To make a backup copy of a CD, follow these steps:

1. Select the source drive from which you want to copy the CD. This can be 
your CD-R, CD-RW, or CD-ROM drive. See “Source CD-ROM Drives for 
CD-to-CD Copying” in the CD Copier online Help if you are going to 
copy directly from a CD-ROM drive.

2. Select the destination drive that contains the blank CD. This is your 
CD-Writer Plus.

3. Make changes, if any, in the Advanced tab settings. See “CD Copier 
Advanced Tab Settings” on page 8-4.

4. Select one of the following options:

■ Test—Select this option to perform a test in which the files to be 
recorded are passed to the CD recorder. No information is recorded to 
the CD. Use this option if you have made any changes to your CD 
recorder setup.
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■ Test & Copy—Select this option to perform a test in which the files to 
be recorded are passed to the CD recorder. Recording begins after a 
successful test.

■ Copy—Select this option when you do not want to perform the test. 
Use this option if you have successfully recorded a number of similar 
CDs and you have not made any changes to your CD recorder setup.

5. Select the number of copies you want to make.

6. Click Copy to begin recording a copy of your CD.

7. Follow the on-screen instructions and insert a blank CD when prompted 
(if you did not already insert one earlier).

CD Copier begins copying the files and folders from your source to a 
blank CD. A final message box notifies you when the copying is 
complete.

CD Copier Advanced Tab Settings

Setting Description

Current CD 
Recorder Speed

Select the speed at which you want to create the 
backup copy of the CD. For greater certainty, 
record at 1x.

Disc Copy Select this option to copy the source CD to your 
hard drive first to speed up the recording process 
if you are making more than one copy of a CD. 
Once the source has been copied to your hard 
drive, CD Copier records the disc copy to the CD.

Select Location To make a disc copy, type in a different location 
to store the image file if you do not want to use 
the Temp directory.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about CD Copier, refer to the appropriate topics in the 
online Help. To access the CD Copier online Help, select Help Topics 
from the Help menu.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 9:
Find Files Fast with 
HP Simple Trax

If you're looking for the easiest way to save, manage, and find your files 
on CD, HP Simple Trax is the answer. 

What Simple Trax Can Do for You

Automatic file backup to CD—Simple Trax has a  Wizard to help you   
easily configure the software to automatically copy files to CD on the 
days and times you choose.

Find Files Fast on your CDs—Even if the CD is not in the drive. Simple 
Trax keeps the contents of all your Simple Trax CDs close at hand in an 
index you access in Windows Explorer.

You can find the files you want quickly even if you’ve forgotten what you 
named them because Simple Trax makes it easy to see what your files 
contain. Just hold your mouse over a filename and Simple Trax gives you 
summaries of text and small versions (thumbnails) of graphic files. 

Keep track of several CDs easily —The contents of all your Simple Trax 
CDs are easily browsed through Windows Explorer.

Give You Peace of Mind—Have comfort knowing that once you save 
your files, HP Simple Trax will show you the contents of the files and 
where to find them.

Simple Trax even maintains previous versions of your files and can 
quickly recover them should the need arise.
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Copying Files to CD
You can copy files to CD several ways with Simple Trax. You can copy 
them to CD from Windows Explorer or you can set up Simple Trax to 
copy files at scheduled times. The schedule can be set using the Wizard 
or, if you want to use more advanced options, from the Control Panel. 

Using Windows Explorer to Copy Files

To copy files using Windows Explorer:

1. Place the CD you want to use into your CD-Writer Plus. 

2. If the CD is new, it will need to be formatted. If not, skip to step 4. If it 
does need to be formatted, after a few seconds a screen will appear which 
asks you to "Please select the type of CD you wish to create.”  

3. Choose Click here to create a data CD that will be accessible through 
a drive letter, i.e. as you would use a floppy drive. Follow the 
instructions on the screen. When the CD is done formatting, continue 
with the next steps. 

4. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

There are two ways to copy the files:

Click the file or folder you want to copy to CD with the right mouse 
button. A popup menu appears. On the popup menu, point to HP 
Simple Trax and click Protect. 
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Click on the folders and/or file(s) you want to copy with the left button 
and drag and drop them onto the Simple Trax Index icon  located on the 
left side of the Windows Explorer screen. You may need to scroll down to 
see it.

If the CD you placed in your CD-Writer Plus has not been used with HP 
Simple Trax before, the program prompts you to type a name to identify 
the CD. This name is used in the HP Simple Trax Index for identification. 
Be sure to write the same name on the CD label with a felt-tip pen.

5. HP Simple Trax will now copy the selected file(s) and folder(s) to the CD 
in your CD-Writer Plus and place information about the files into the 
Simple Trax Index.

Automatically Copying Files to CD
You can have Simple Trax automatically copy files to CD for you. You 
specify how often—once a day, once a week, whatever schedule you 
choose—you can also specify the types of files to copy. For example, you 
could set up a schedule for Simple Trax to copy all your spreadsheet files 
each Monday at noon. Then, just leave your computer on with a CD in 
the drive and Simple Trax will take it from there.

Simple Trax Index icon
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Preparing a CD for Automatic Operations

For a Simple Trax session to run unattended you will need to have a CD 
that is formatted and has a name for use in HP Simple Trax. To prepare 
the CD you will:

■ Format it 

■ Use Simple Trax to copy at least one  file so you can give the CD a 
name for use in the Simple Trax program

To prepare a CD for automatic operations:

1. Place the new CD into your CD-Writer Plus. After a few seconds a screen 
will appear which asks you to "Please select the type of CD you wish to 
create.”  

2. Choose Click here to create a data CD that will be accessible through 
a drive letter, i.e. as you would use a floppy drive. Follow the 
instructions on the screen. When the CD is done formatting, continue 
with the next steps.

3. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

4. Click the file or folder you want to copy to CD with the right mouse 
button. A popup menu appears. On the popup menu, point to HP 
Simple Trax and click Protect. 

HP Simple Trax will now copy the selected file(s) and folder(s) to the CD 
in your CD-Writer Plus and place information about the files into the 
Simple Trax Index.
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5. Simple Trax will then prompt you to type a name to identify the CD. This 
name is used in the HP Simple Trax Index for identification. Be sure to 
write the same name on the CD label with a felt-tip pen.

Using the Wizard to Set a Schedule

The Wizard is the easiest way to set up a Simple Trax schedule. If you 
want more control over how you set up the schedule, you might want to 
review the section, “Using the Control Panel to Set up a Schedule” on 
page 9-6.

To use the Wizard:

1. Click the Start button and point to Programs, then to HP CD-Writer 
Plus, then to HP Simple Trax, and click HP Simple Trax Control Panel. 
The Control Panel appears:

2. Click on the Run Wizard instead button near the bottom of the Control 
Panel.

3. Follow the instructions on the screen.

Before an Automatic Operation will Run

If you plan to use a new CD for the automatic operation, be sure to read 
the section, “Preparing a CD for Automatic Operations” on page 9-4. It 
will teach you how to format and name the CD. If a prepared CD is not 
inserted, the scheduled operation will not begin.

Click to 
start the 
Wizard.
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Your computer must be left on for the operation to run.

Using the Control Panel to Set up a Schedule

The HP Simple Trax Control Panel allows the most customization when 
setting up a schedule.

To use the Control Panel:

1. Click the Start button and point to Programs, then to HP CD-Writer 
Plus, then to HP Simple Trax, and click HP Simple Trax Control Panel. 
The Control Panel appears. 

2. Click on the Selection tab towards the top of the Control Panel. The 
Selection screen appears:

3. On the left side of the screen, you can click on the box next to the types 
of files you want to copy to CD on a regular basis. For example, you 
might want to copy all files with the extension .doc. Several file types 
have been chosen as default. If you like, you can accept or change the file 
types Simple Trax has chosen.

On the right side of the screen you can specify any folders you want to 

Click here to 
add a custom 
file type.

Click on the boxes to 
select or deselect file 
types you want 
copied to CD on a 
regular basis.

Click on the 
boxes to select
folders you 
want to copy 
to CD on a 
regular basis.
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copy to CD on a regular basis. Click on the box next to the appropriate 
folders. 

4. Click the Schedule tab towards the top of the screen. The Schedule 
screen appears:

5. Click the box next to the days(s) on which you want scheduled 
operations to run. Click on the arrows to set the time you want to copy 
the files. When you are finished, click on the Add to Schedule button. 
Continue adding dates and times, if desired.

6. When you are finished selecting your schedule, click OK. 

Before an Automatic Operation will Run

If you plan to use a new CD for the automatic operation, be sure to read 
the section, “Preparing a CD for Automatic Operations” on page 9-4. It 
will teach you how to format and name the CD. If a prepared CD is not 
inserted, the scheduled operation will not begin.

Your computer must be left on for the operation to run.
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Adding Custom File Types

You can create custom  file types. For example, if you work with text 
documents (.html) and video clips (.jpg) to create Web pages you may 
want to create a custom file type called Web Pages. 

To add a custom file type:

1. Click the Start button and point to Programs, then to HP CD-Writer 
Plus, then to HP Simple Trax, and click HP Simple Trax Control Panel. 
The Control Panel screen appears. 

2. Click on the Selection tab towards the top of the screen. The Selection 
screen appears:

Click here to 
add a Custom 
File Type.
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3. Click on the plus-sign button in the Selection window. The Custom File 
Type window appears:

4. Type the name of the category in the description field. Next, type the file 
extensions in the lower window separated by commas. (Do not type the 
period before the extensions.) This example shows the group Web Pages 
that includes the file extensions html and jpg. When you’re finished, 
click on Add Type. The Selection screen will reappear.

To Verify Your Schedule Settings
1. Click the Start button and point to Programs, then to HP CD-Writer 

Plus, then to HP Simple Trax, and click HP Simple Trax Control Panel. 
The Control Panel screen appears.

2. Click on the Selection and Schedule tabs towards the top of the screen 
to view your current settings. 

To Change a Schedule
1. Click the Start button and point to Programs, then to HP CD-Writer 

Plus, then to HP Simple Trax, and select HP Simple Trax Control 
Panel. The Control Panel screen appears.

2. Click the Schedule tab. The Schedule screen appears.
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3. To change a schedule Click the box next to the day you want to a 
scheduled operation to run, then adjust the time you want to copy the 
files. When you are finished making changes click on the Add to 
Schedule button. 

4. To remove a schedule, highlight the item on the right side of the screen, 
then click on Remove from Schedule.

5. If you want to make changes to the items you've selected to be copied, 
click on the Selection tab towards the top of the screen. Select or deselect 
items you want to include or exclude.

6. When you are finished making changes, click OK. 

Browsing Your Simple Trax CDs
You can view the files that are on your Simple Trax CDs from Windows 
Explorer. If you are looking for a specific file, follow the directions in the 
section, “Finding Files On Your CD” on page 9-11.

1. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

2. Double-click on the Simple Trax Index icon on the left side of the 
Windows Explorer window. You may need to scroll down to see it. The 
contents of the index appear in the right side of the Windows Explorer 
window.
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3. Point to a filename in the index. If it is a graphic file, you will see a 
thumbnail preview of the file. If it is a text file, you’ll see a short 
summary of the file’s contents.

Finding Files On Your CD
It is easy to locate files on your Simple Trax CDs. You can search by 
keywords, dates, filename, and file type. 

To find a file on your CD:

1. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

Thumbnail preview of the 
file mundo.gif
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2. From the Tools menu, point to Find, then click on In HP Simple Trax. 
The Find Files screen appears: 

3. In the Filename box type all or part of the name of the file you want to 
find.

4. To limit Simple Trax to searching only specific file types, select the 
appropriate checkboxes in the File type window.

5. You may also search by one or more words contained in a file. Click on 
the Words in File tab towards the top of the screen. Type the word on 
which you want to search in the space, then click Add to list.
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In the example shown in the Find Files illustration, Simple Trax will find 
files containing "dog" or "cat" or "bird".

6. If you want to search for a file that was modified on or between certain 
dates, click on the Date Modified tab towards the top of the screen. You  
can search for files between specific dates or over a period of time. After 
you make your selections click on OK.

7. When you are finished making selections, click on Start Search. When 
the software is finished finding the files, the results are displayed in the 
Refine Results window. If you wish to narrow your results, read the 
following section, Narrowing Your Search. 
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Narrowing Your Search

When you are finished entering search criteria the results appear in the 
Refine Results screen:

You may want to narrow your search further by date, file type, or search 
words.

To refine by date:

Move the sliders back and forth until the range of dates you want appear 
on either corner of the box. The results window will update as you 
change the date.

To refine with File Types

Click on the File Type tab in the middle of the screen. To limit the file 
types that appear in the results window, click on the appropriate 
checkboxes. The results window will be updated.

To refine with Search Words

If you want to modify the words you used as search criteria, click on the 
Search Words tab in the middle of the screen.  Type the word you want to 
include as a search criteria in the space, then click Add to list.  Remove a 
search word by highlighting it and clicking on Remove From List. The 
results window will update. 
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Copying Files and Folders Back to Your 
Hard Drive

Retrieving protected files and folders using HP Simple Trax is quick and 
easy. You don't need to insert a CD into your CD-Writer Plus before the 
retrieval actually begins. HP Simple Trax shows you all the files and 
folders you have copied to CDs. The software then prompts you for the 
correct CDs after you’ve selected the file(s) or folder(s).

To retrieve files and folders:

1. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

2. Double-click the Simple Trax Index icon. You may need to scroll down to 
see it. The contents of the CDs appear in the right side of the Windows 
Explorer window.

3. Use the right mouse button to click on the file or folder you want to 
retrieve. A popup menu appears: 

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse 
button. Then release the CTRL key and click with the right mouse 
button.
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4. Click Retrieve from the popup menu. The Retrieve screen appears:

5. Set the retrieve options:

Ask before overwriting files—Normally Simple Trax will ask before 
overwriting files of the same name. Clear this box only if you want 
Simple Trax to overwrite files without asking first. 

Include subdirectories—Check this option to retrieve all subdirectories 
in the selected folder. (This option is useful only if you have selected one 
or more folders.)

Copy files to an alternate location—Use this option to copy files to a 
different location on your hard drive than from where they were 
originally copied. Type the desired drive and path or click Browse and 
select the new location from the list of folders on your hard drive(s). If 
you do not choose this option, your files will be copied back to their 
original location. 

6. Click OK to continue. If the correct CD is not  in the drive HP Simple 
Trax prompts you for the required CD. HP Simple Trax retrieves the most 
recent versions of selected files.

Retrieving an Earlier Version of a File
Earlier versions of a file can be retrieved using the View Versions option. 
You can use this feature to view or recover files saved prior to major 
revisions.
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To retrieve an earlier version of a file:

1. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

2. Click the file on your hard drive that you want to retrieve with the right 
mouse button, point to HP Simple Trax on the popup menu, and select 
View Versions. The File Protection History dialog box appears:

3. Click the desired version and click the Retrieve File button. Older 
versions of a file can only be retrieved one at a time.

Importing CDs into HP Simple Trax
If you have CDs that were created before you installed Simple Trax, you 
can still have Simple Trax keep track of their contents by "importing" the 
CD into Simple Trax. When you import a CD, HP Simple Trax gathers 
information about the files on the CD and stores that information on 
your hard drive. This information makes it possible for you to easily find 
and retrieve files and to browse the contents of the CD without putting 
the CD in your CD-Writer Plus.
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There are several cases in which you may want to import a CD:

■ To start tracking files that you have previously copied to CDs without 
using HP Simple Trax

■ If you want to start tracking files on a CD created by someone else or 
a commerically made CD

■ If for any reason the information HP Simple Trax stores on your hard 
drive is lost or damaged you can reconstruct that information by 
importing all Simple Trax CDs

To import a CD into HP Simple Trax:

1. Place the CD you want to import into your CD-Writer Plus.

2. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

3. With your right mouse button, click on the drive icon for your CD-
Writer. A popup menu appears:

4.  Point to HP Simple Trax and click Import from the HP Simple Trax 
menu. The Import Wizard appears.

5. Follow the instructions on the screen. The import process can take 
anywhere from a couple of minutes to over an hour. The duration of the 
operation depends mainly on the type of computer you have and the 
number of files on the CD.
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Event Logs
An event log is automatically created every time a Simple Trax operation 
runs—such as a retrieve, import, or scheduled copy. Look at the event log 
for additional information if an error message appears during an 
operation.

To view an Event  Log: 

1. Point to Start, then to Programs, HP CD-Writer Plus, then to HP 
Simple Trax, and click HP Simple Trax Control Panel. The Control 
Panel Screen appears.

2. Click on the Event Log tab towards the top of the screen.

3. Highlight the event log you want to see and click on View.

To delete an event log:

1. Highlight the event log you want to delete and click Delete.

NOTE: When you delete an event log, it cannot be restored.

Changing the Index Display
You can view the index by folder or by CD. The initial setting is to 
display the contents of a CD by folders.

To change the way the index is displayed:

1. Run Windows Explorer by clicking the Start button, pointing to 
Programs, and clicking Windows Explorer.

2. Click on the Simple Trax Index icon. You may need to scroll down to 
see it.

3. From the View menu, highlight HP Simple Trax View Options, then 
click on either By CD or By Folder.

Choosing By CD will display the contents of your index by the CD on 
which the files are located.  Choosing By Folder will display the contents 
of your index by folders.
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Chapter 10:
HP Disaster Recovery

HP Disaster Recovery is an application that will help you to recover your 
data and operating system after a hard-drive failure. It is important that 
you create a Disaster Recovery Set as soon as possible. Should a disaster 
occur, the information in the Disaster Recovery Set will enable you to 
return your system to the state it was in at the time you created your 
Disaster Recovery Set.

Getting Started
The first step in securing the data on your system is creating the Disaster 
Recovery (DR) Set. The DR Set will contain the information necessary to 
recover your system. A new DR Set should be created when new hardware 
or software has been added to your system, or if many changes have been 
made to your files since the last DR Set was created. 

The Disaster Recovery Wizard will guide you through the steps required 
to create the DR Set with easy-to-follow instructions for protecting your 
valuable data. Once the DR Set has been created, it will allow you to 
recover your system should your hard-drive fail, even if your Windows 
operating system will not start. 

When you install HP Disaster Recovery, the program and its folder are 
added to the Windows Start Menu. 
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What you will need

To create the Disaster Recovery Set, you will need the following items:

For Windows 95 and Windows 98

■ One or more blank, formatted 1.44MB diskettes*

■ One or more blank HP CD-R/CD-RWs*

■ Windows 95/98 installation CD or install set

What is an install set?  An install set is the list of files used to install 
a product or operating system. Computers shipped with pre-installed 
operating systems (i.e. Windows 95/98) may not include a Windows 
installation CD. In this case, HP Disaster Recovery will require your 
Windows install set to create the Disaster Recovery Set. 

For Windows NT

■ Four (4) blank, formatted 1.44MB diskettes

■ One or more blank HP CD-R/CD-RWs*

■ Windows NT installation CD

*The number of diskettes and CD-R/CD-RWs required will depend on the 
amount of data on your system. 

Creating the Disaster Recovery Set

To create your Disaster Recovery Set:

1. Click the Start button located on the Windows taskbar. Select Programs, 
HP CD-Writer Plus, HP Disaster Recovery, then select Disaster 
Recovery.

HP Disaster Recovery Wizard appears. 

2. Follow the instructions on the Wizard screens to create your Disaster 
Recovery Set.

It is recommended that you label your diskettes and CD(s) when 
prompted in the Wizard, and store them in a safe place. A new DR Set 
should be created when new hardware or software has been added to 
your system, or if many changes have been made to your files since the 
last DR Set was created. 
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Partitioning Your Drive(s)

In the event that you must perform a recovery, HP Disaster Recovery will 
require that you partition your new drive(s) to the same settings as were 
set before the drive failure. In order to do this, it may be helpful to make 
a record of your current partition settings on paper and keep an updated 
record of these settings with each DR Set. 

What is a partition? A partition is a logical section of your hard 
disk. One physical hard disk may be partitioned into two or more 
logical hard-drives.

To make a record of your partition settings:

1. Double-click the My Computer icon located on your desktop. 

The My Computer Window appears.

2. Select Details from the View menu.

A list of drive types will appear under the Type heading, to the right of 
your drive letter. 

3. Under the Name heading, right-click on the drive letter listed as a Local 
Disk, then select Properties.

The selected drive’s Properties dialog box appears.

4. Write down the information displayed in the Type dialog.

5. Write down the information displayed in the Capacity dialog.

6. Repeat steps 3-5 for each Local Disk on your computer.

Testing your Disaster Recovery Set

After you have created the DR Set, you will be asked if you would like to 
test the DR Set. Testing the DR Set is very similar to performing an actual 
recovery; however, be sure to stop testing when instructed to do so. This 
test is to verify that your drive is responding properly.

To test your Windows 95/98 Disaster Recovery Set:

1. Follow steps 1 through 8 in the Windows 95 and Windows 98 section of 
“Recovering Your Data.”
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WARNING: Be sure to discontinue testing the DR Set when instructed to do so. 
By proceeding with the recovery process, you would be recovering the data from 
the CD which would overwrite the data on that drive.

2. If you do not receive the messages listed in the steps for data recovery, 
follow the directions for creating another Disaster Recovery Set. See 
“Creating the Disaster Recovery Set” on page 10-2.

To test your Windows NT Disaster Recovery Set:

1. Follow steps 1 through 8 in the Windows NT section of “Recovering Your 
Data.”

WARNING: Be sure to discontinue testing the DR Set when instructed to do so. 
By proceeding with the Disaster Recovery Wizard, you would be recovering the 
data from the CD which would overwrite the data on that drive.

Recovering Your Data
If you are certain that you have lost your data due to a major system 
problem, such as a hard-drive failure, it will be necessary to recover your 
data by using your most recent Disaster Recovery Set. 

HP Disaster Recovery uses the data located on your Disaster Recovery Set 
to restore your files and other vital system information to your new or 
replaced hard-drive. 

For Windows 95 and Windows 98

The Disaster Recovery process for Windows 95 and Windows 98 takes 
place in DOS. A series of screens will appear in DOS and prompt you to 
insert the media from your Disaster Recovery Set. 

What is DOS? DOS is a simple operating system that resides on your 
Windows 95/98 Startup Disk.

To recover your data:

1. You should first decide if another recovery method is possible. For 
example, if the problem appears to be associated with the Windows 
operating system, such as a corrupt registry, try to recover by following 
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the steps outlined in your Microsoft Windows User’s Manual before 
attempting the following procedures. If you have determined that a hard-
drive failure has occurred, proceed to Step 2.

2. Replace any damaged hard-drives with comparable drives. 

In order to recover all of your information, HP Disaster Recovery must 
have at least as much hard disk space as existed before the drive failure.

3. Insert the Windows Startup Disk (diskette #1 of the DR Set) into the 3.5” 
floppy drive from which your computer boots, and restart your 
computer.

A DOS screen appears.

4. If a Windows Startup Diskette #2 was created (not all systems require the 
creation of this diskette), insert Diskette #2 into the 3.5” floppy drive 
from which your computer will boot. 

5. At the prompt, type A:\README then press Enter. 

The README.TXT appears. 

6. After reading the text, press Alt+F, then press X to exit the editor.

It may be necessary to prepare your hard disk using the following tools 
which are located on the Disaster Recovery Diskette:

■ FDISK—Re-partitions your hard disk

■ FORMAT—Formats one or more partitioned drives

■ SYS—Installs the system boot files onto the hard disk

NOTE: For instructions on the use of these utilities, please refer to your 
operating system user manual or contact Microsoft.

7. At the prompt, type A:\RECOVER and press Enter. Your DR files will be 
copied from the diskette to your hard-drive.

The following message should appear:

Please insert Disaster Recovery CD #1 into your 
HP CD-Writer Plus.

8. Insert Disaster Recovery CD #1 into your HP CD-Writer Plus drive, then 
press Enter.
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NOTE: If your Disaster Recovery Set consists of more than one CD, you will be 
prompted to insert each of the CDs in the order they were created.

The following message should appear: 

Test successful. To continue your recovery, 
select RECOVER. 

If you are testing, select EXIT.

9. To continue recovering your system, press F5.

Or,

To exit the Disaster Recovery process, press F10, remove any diskettes or 
CDs from your drive(s) and restart your computer.

WARNING: If you are just performing a test of your Disaster Recovery Set, the 
test is now complete. Do not continue past this step. Please remove any 
diskettes and CDs from your drive(s) and restart your computer. 

The following message should appear:

Select  the  volume that  you   wish to  recover.                                                   

Drive C: [Volume C Name]                                                                              
Drive D: [Volume D Name]

NOTE: If you have only one drive, it will be automatically selected for recovery 
and this screen will not be displayed.

10. Select the volume that you wish to recover by highlighting the volume 
using the Up and Down arrow keys, then pressing Enter.

You will then be asked to confirm your selections before recovering your 
information. 

11. Press Enter to confirm your selections, or press Esc to return to the 
previous screen(s) and make a different selection. 

NOTE: If Disaster Recovery CD #1 is not in your HP CD-Writer Plus, you will 
be prompted to insert it at this time.

HP Disaster Recovery will now begin recovering your system. 
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The recovery process will take some time to complete, depending upon 
the amount of data you are recovering. You will be prompted to insert 
the CDs in the order they were created.

12. Once the volume has been recovered, a summary of the process will be 
displayed. To exit this screen, press Enter. If there is more than one 
volume to be recovered, you may select it at this time.

After recovering the volume(s), you may wish to view the REPORT.TXT 
file which contains a text summary of the files that could not be 
recovered. If you wish to view this file, you must first exit the program by 
pressing Esc twice, then type EDIT REPORT.TXT. After reading the 
text, press Alt+F, then press X to exit the editor. For more information on 
files that could not be recovered, see “Files Not Recovered” on page 1-9.

Your recovery is complete. Remove any diskettes and CDs from your 
drive(s) and restart your computer. 

NOTE: It may be necessary to restart your computer more than once if any 
hardware in your system has changed since your DR Set was created.

For Windows NT

The Disaster Recovery process for Windows NT begins with a minimal 
install of the Windows NT Workstation, performed from the Disaster 
Recovery Set.

HP Disaster Recovery screens will display messages instructing you when 
to insert the diskettes and CD(s) from your Disaster Recovery Set. Once 
the Setup portion of the minimal install has been completed, the Disaster 
Recovery Wizard will appear and guide you through the rest of the 
recovery process.

To recover your data:

1. You should first decide if another recovery method is possible. For 
example, if the problem appears to be associated with the Windows 
operating system, such as a corrupt registry, try to recover by following 
the steps outlined in your Microsoft Windows User’s Manual before 
attempting the following procedures. If you have determined that a hard-
drive failure has occurred, proceed to Step 2.

2. Replace any damaged hard-drives with comparable drives. 
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In order to recover all of your information, HP Disaster Recovery must 
have at least as much hard disk space as existed before the drive failure.

3. Insert the Windows NT Workstation Setup Boot Disk (diskette #1 of the 
DR Set) into into the 3.5” floppy drive from which your computer boots, 
and restart your computer. 

You will be guided through a partial NT installation.

4. When prompted, insert Windows NT Workstation Setup Disk #2 into the 
3.5” floppy drive from which your computer boots..

The NT Setup screen should now appear. 

5. Choose Express Setup (recommended) or Custom Setup from the NT 
Setup screen.

■ Express Setup—Should be selected if you do not need to partition 
any drive(s), or if you are testing your DR Set. Select this option by 
pressing Enter.

■ Custom Setup—Should be selected if your primary partition needs to 
be set up, or if your backup device is not located. Also, if the SCSI card 
your device is attached to is not detected, you will need to go through 
a Custom Setup with your Controller Card Installation Diskette. 
Select this option by pressing C on your keyboard.

You should attempt to partition any new drive(s) to the same settings as 
were set before the drive failure. In order to partition your drive(s), select 
Custom Setup and follow the instructions on your screen. Only the boot 
drive and the NT installation drive need to be partitioned at this time. 
You will be able to partition and format other drives at a later time 
through the Disk Administrator in the HP Disaster Recovery process.

After proceeding through an Express or Custom Setup, you will be 
prompted to insert the remaining diskettes and CDs from your Disaster 
Recovery Set.

6. When prompted, insert Windows NT Workstation Setup Disk #3 into the 
3.5” floppy drive from which your computer boots.

7. When prompted, insert your Windows NT installation CD into your HP 
CD-Writer Plus drive.

8. When prompted, insert Windows NT Workstation Setup Disk #4 into the 
3.5” floppy drive from which your computer boots.
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When Setup has finished copying files to your hard disk, you will be 
prompted to remove any floppy diskettes and CDs from your drive(s) and 
restart your computer. Once you have restarted your computer, the HP 
Disaster Recovery Wizard should appear and guide you through the rest 
of the recovery process. 

WARNING: If you are just performing a test of your Disaster Recovery Set, the 
test is now complete. When the HP Disaster Recovery Wizard appears, it is an 
indication that your drive is responding properly to your current Disaster 
Recovery Set. Click Cancel to exit, remove any diskettes and CDs from your 
drive(s) and restart your computer. If you are performing an actual recovery, 
proceed to the next step.

9. Follow the instructions on the Wizard screens to complete the Disaster 
Recovery.

When the Disaster Recovery is complete, the HP Disaster Recovery 
Wizard will report that your data was either successfully recovered, in 
which case you may remove any diskettes and CDs from your drive(s) 
and restart your computer, or a Report button will appear. 

If a Report button does appear on the Wizard screen, click on Report to 
view any files that could not be recovered. For more information on any 
files that could not be recovered, see the following section: “Files Not 
Recovered”.

Files Not Recovered

HP Disaster Recovery will report any file(s) that could not be recovered, 
along with a brief explanation for the reason the file(s) could not be 
recovered in the REPORT.TXT file. 

To view this file:

For Windows 95/98—After recovering the volume(s), you must first exit 
the program by pressing Esc twice, then type EDIT REPORT.TXT. 
After reading the text, press Alt+F, then press X to exit the editor.

For Windows NT—When the recovery is complete, the final Wizard 
screen will display a Report button if there were any files that could not 
be recovered. Click on Report to view this file.
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■ Busy Files—If any files were inaccessible at the time you created your 
Disaster Recovery Set, or at the time of the recovery process, these 
files will be listed in the Report file as not having been recovered.

■ Damaged Media—If the media containing your Disaster Recovery Set 
is damaged, some of the data on that media may not be recoverable. 
Any files that could not be recovered due to damaged media will be 
listed in the Report file. To recover these files, close all running 
applications and use an older Disaster Recovery Set to perform 
another recovery.

■ Damaged hard-drive—If the hard-drive you are recovering to is 
damaged, some files may not be recoverable. Any files that could not 
be recovered due to a damaged hard-drive will be listed in the Report 
file. Replace or fix the current hard-drive and perform another 
Disaster Recovery.

■ Not Enough Disk Space to Restore—In order for HP Disaster 
Recovery to recover all of your information, there must be at least as 
much disk space on the hard-drive to which you are recovering, as 
existed on the hard-drive from which you created your DR Set. If your 
current drive does not contain enough disk space, certain files will be 
listed as not having been recovered. 

To perform a complete recovery:

Re-partition your hard-drive(s) to accommodate your data and 
perform another Disaster Recovery.

Or,

Replace your current hard-drive with a larger hard-drive and perform 
another Disaster Recovery.
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Appendix A:
Technical Specifications

Minimum System Requirements
Your computer should meet or exceed these requirements:

■ IBM or compatible Pentium/133 Mhz processor or above

■ Microsoft® Windows 95®, Windows 98®or Windows NT® 4.0

NOTE:  For Windows NT, Service Pack 3 or greater is required.

■ 32 MB RAM

■ Hard drive with at least 528 MB storage capacity

■ 35 MB free hard drive space for installing the software described in 
the User’s Guide

■ High-speed parallel port (EPP or ECP) set to:
- IRQ 7 and I/O address 378 or 
- IRQ 5 and I/O address 278

In Windows 95/98, to check the configuration settings of your parallel 
port:
- Right-click on the My Computer icon
- Select Properties
- Select the Device Manager tab
- Double click Ports (COM & LPT)
- Highlight Printer Port
- Click on the Properties button
- Select the Resources tab
- Look at the numbers listed for Input/Output Range (I/O)
  and Interrupt Request (IRQ)

If the numbers need to be changed, see the documentation that came 
with your computer.
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If your driver installation diskette is lost or damaged:

To create a driver installation diskette, insert “Software Disc 1” into 
the CD-ROM drive. From the main menu, click Browse this CD. 
Double-click the CopyDisk folder and then double-click 
Copydisk.exe. Select the Driver Installation Diskette option and 
follow the instructions. 

What Affects System Performance
How well your computer functions with the CD-Writer Plus drive, 
particularly how fast it writes data to a CD, depends on a number of 
factors. Some of these factors are listed below.

■ Processor (CPU). The type and speed of your processor greatly affects 
the speed at which your computer transfers data to and from the CD-
Writer Plus drive. If the processor speed is too slow, you may have to 
write at 1x speed.

■ RAM. Your computer must have enough memory available to handle 
its operating system, the CD-Writer Plus drive’s applications, and the 
data you are transferring to and from CDs. The system should not 
have to swap data to and from the hard drive.

■ Your Hard Drive. The speed at which your hard drive accesses and 
transfers data (its access time and transfer rate) affects performance. 
Newer hard drives, those with a storage capacity greater than 528 MB, 
are fast enough to handle the CD-Writer Plus drive’s 2x write speed.

■ Parallel Port Type. The type of parallel port on your computer has a 
major influence in determining the speed at which your CD-Writer 
Plus drive runs. Possible parallel port types are:

■ Standard parallel port (SPP) which is sometimes called bi-
directional or compatible

■ Enhanced parallel port (EPP)

■ Extended capabilities port (ECP)

Most PCs shipped since January 1995 contain support for the 
required high-speed EPP and ECP modes. Systems shipped before this 
date may only support SPP.
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SPP mode allows the CD-Writer Plus drive to run at up to a 2x read 
speed and up to a 1x write speed if the other minimum system 
requirements are met.

EPP and ECP modes allow the CD-Writer Plus drive to run at up to a 
6x read speed and a 2x write speed if the other minimum system 
requirements are met.

TIP: Check your computer’s specifications to see which kind of parallel port was 
installed. Sometimes a fast ECP/EPP port will be set up as a slow standard 
mode port at the factory. Check your computer’s manual to find out how to reset 
it to the faster speed. If that doesn’t work you can also install a faster parallel 
port.

■ I/O and IRQ. The IRQ (interrupt request) and I/O (input/output) 
range are the computer resources used by the parallel port. The CD-
Writer Plus drive requires a parallel port set to:

IRQ 7 with I/O base address 378, or 

IRQ 5 with I/O base address 278

Most computers automatically assign these. But, depending on your 
configuration, you may run into conflicts with other devices. For 
example, another device (such as your sound card) may be assigned 
the same settings. If there is a conflict, it must be corrected before 
installing the drive.

To find out which device is in conflict:

In Windows 95/98, right-click on the My Computer icon, select 
Properties, select the Device Manager tab, double-click on the 
computer icon to see a list of which device is using each resource 
setting on your computer.

■ For optimum performance, run SCANDISK.EXE and DEFRAG.EXE 
on your hard drive before using your CD-Writer Plus drive for the first 
time (see your Windows manual for more information). Then run 
them periodically after that. These programs improve access times to 
the hard drive, which will help improve system performance while 
writing to and reading from the CD-Writer Plus drive.

NOTE: Refer to your computer manual or contact your computer vendor if you 
have any questions about your computer’s configuration or capabilities.
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Product Specifications
ISO 9660 Disc Data Capacity (74 Minute CD)

*1 MB is defined as 106 bytes

UDF 1.5 Disc Data Capacity (74 Minute CD)

530 MB for CD-RW

618 MB for CD-R

Performance

Buffer size: 991 kB to 975 kB (depending on writing mode)

Average access time (1/3 stroke): <125 ms

Data transfer rate (recording):
150 KB/s sustained (1x speed)
300 KB/s sustained (2x speed)

Data transfer rate (reading):
150 KB/s (1x speed, CLV mode)
300 KB/s (2x speed, CLV mode)
up to 900 KB/s (6x speed, CAV mode)

Error rate: < 1 frame/1012 bits

Audio distortion: < 0.1%

Number 
of 
sessions

Size required for header 
information

Size available for data/
per session

1 approximately 23 MB* 627 MB one session

5 approximately 79 MB
(approx. 23 for the first, 
14 MB each of the rest)

114 MB each session

10 approximately 149 MB
(approx. 23 for the first, 
14 MB each of the rest)

50 MB each session

30 approximately 430 MB
(approx. 23 for the first, 
14 MB each of the rest)

7.4 MB each session
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Discs supported

120 mm and 80 mm CD-R (write-once) media 

120 mm CD-RW (ReWritable) media 
For a description of which CD drives can read discs created with 
certain application/media combinations see the interchange 
summary on page 4-5.

Interface

Electrical interface: 
parallel port EPP/ECP

Loading mechanism: tray

Logical recording format (depending on application used): 
ISO 9660
UDF 1.5
CD-DA

Dimensions

Height: 66 mm (2.6")

Width: 180 mm (7.1")

Depth: 284 mm (11.2") 

Weight (net): 2.157 Kg (4.7 lbs) 

Environmental

Temperature
operating: 10°C to 35° C (50°F to 95°F)
nonoperating: -40°C to 70° C  (-40°F to 158°F)

Humidity (no condensation allowed)
operating: 10% to 80% RH
nonoperating: 5% to 90% RH

Shock and Vibration
HP Corporate Environmental Test Class B1

Power requirements
Typical usage: 10.7 W
Maximum usage: 12.4 W
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Appendix B:
Customer Support

Before You Call HP
If your own troubleshooting efforts fail, contact Customer Support. Make 
sure you are at your system and have your drive installed when you call. 
Phone numbers begin on page B-5. Before you contact them, have the 
information below ready. For help finding this information, see page B-2. 
If you receive an error message, write it down before you call.

Information For your computer

CD-Writer Plus drive model

Drive firmware version

Drive serial number

Computer brand and model

Operating system and version Windows 95, Windows 98, or Windows NT 
4.0 Version:
(for NT) Service Pack Number:

Amount of RAM installed

Other CD-ROM drives? yes/no
(If yes, list them)

Sound card? yes/no Type:

Parallel port type
and system resources in use

EPP, ECP, other 
IRQ _______
I/O port _______
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Where to Find This Information

CD-Writer Plus drive model

The CD-Writer Plus drive model number appears on the front of the CD-
Writer Plus drive, as well as on the box. Example: 7500 Series

Drive firmware version

In Windows 95 and Windows 98, the drive firmware version and model 
number (above) appear in the CD-ROM settings. Right-click on the My 
Computer icon, select Properties, select the Device Manager tab, 
double-click on CDROM. Double-click on the CD-Writer Plus drive, and 
then click on the Settings tab. Example: Firmware revision 1.00

In Windows NT, the drive firmware version and model number (above) 
appear in the CD-ROM settings. Open the Control Panel. Then do one of 
the following:

■ Click on SCSI. Scroll down the list, double-click on ATAPI. Double-
click on the CD-Writer Plus drive, and then click on the Settings tab. 
Example: Firmware revision 1.00

■ Click on SCSI. Scroll down the list, double-click on “Shuttle parallel-
to-ATAPI CD.” Double-click on the CD-Writer Plus drive, and then 
click on the Settings tab. Example: Firmware revision 1.00

Drive serial number

The CD-Writer Plus drive serial number appears on a sticker on the back 
of the CD-Writer Plus drive.

Computer brand and model

The computer brand appears on the front of your computer and in the 
documentation that came with your computer. Example: HP Pavilion 
8190.

Printer connected to the CD-
Writer Plus drive? What kind?

CD-Writer Plus in warranty? See 
page xi

Information For your computer

Download from Www.Somanuals.com. All Manuals Search And Download.



Before You Call HP B-3

A
p

p
en

d
ix B

:  C
u

sto
m

er 
Su

p
p

o
rt

Operating system and amount of RAM installed

In Windows 95 or Windows 98, from the Start menu on the task bar, select 
Settings/Control Panel.  Double-click on System.  Select the General 
tab.  Write down the version number and the amount of memory 
installed; for example:  4.00.950 and 32 MB RAM.

In Windows NT (while signed on as Administrator), from the Start menu 
on the task bar, select Programs/Administrative Tools (Common)/
Windows NT Diagnostics.  Select the Version tab and write down the 
version number and service pack number; for example:  4.00.1381 and 
Service Pack 3.  Then select the Memory tab and write down the amount 
of memory listed under Physical Memory - Total; for example:  32 MB 
RAM.

Other CD-ROM drives

Your computer may have come with an internal CD-ROM or you may 
have purchased a CD-ROM drive. Check the documentation that came 
with your computer or CD-ROM drive. Example: Mitsumi 4x CD-ROM

Sound board

Your computer may have come with a sound board and speakers or you 
may have purchased them separately. Check the documentation that 
came with your computer or sound board. Example: Sound Blaster

Parallel port type and system resources in use

In general, computers manufactured after January 1995 have the 
required high-speed parallel port (EPP or ECP). Check the manuals that 
came with your computer to confirm this. Older computers generally 
have a slower standard port. Example: standard, bidirectional

In Windows 95 or Windows 98, display the Device Manager. Double-click 
on Ports (COM & LPT). Double-click on the printer port, and then click 
on the Resources tab. Example: I/O Range 0378-037B, Interrupt Request 7.
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HP Customer Support
If you need help with your CD-Writer Plus drive, your local reseller has the latest 
information regarding HP products and services and can provide support under HP's 
comprehensive menu of reseller services. If your reseller is not able to help, you can 
obtain support from HP directly either through free 24-hours/day interactive electronic 
services or by telephone (free during warranty). To get help with the software that came 
with CD-Writer Plus, call the appropriate number listed below (free during warranty).

America Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . Keyword: hpstor

CompuServe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Go HPSYS

World Wide Web  . . . . . . . . . . . . . .www.hp.com/isgsupport/cdplus

Bulletin board site (8,N,1,F, 1200-28.8K baud) 
Europe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +31 (0)495 546909
Asia/Pacific

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9890 0276
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Hitel: (02) 762-0228 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Access: Go HPK 
 . . . . . . . . . . . . . . . . . . . . . . . . . . . Chollian: (02) 220-2001

New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . (09) 356 6642
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)9233233
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . First Name: HP
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Last Name: BBS

HPFirst Faxback Service 
Simply dial the fax number from a touch-tone phone or Group 3 fax machine and 
follow the voice prompts to select the index of available support and product 
information documents.

USA and Canada  . . . . . . . . . . . . . . . 800-368-9673 or 970-635-1510
Europe

Austria (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0660 8128
Belgium (free line)
- Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0800 11906
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0800 17043
Denmark (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . 800 10453
Finland (free line). . . . . . . . . . . . . . . . . . . . . . . . . . . 9800 13134
France (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 05 905900
Germany (free line)  . . . . . . . . . . . . . . . . . . . . . . . 0130 810 061
Italy (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1678 59020
Netherlands (free line) . . . . . . . . . . . . . . . . . . . . . . 06 022 2420
Norway (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . 800 11319
Spain (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 900 993123
Sweden (free line). . . . . . . . . . . . . . . . . . . . . . . . . . . 020 795743
Switzerland (free line)
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155 1526
- German  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155 1527
United Kingdom (free line)  . . . . . . . . . . . . . . . . . . 0800 960271
Other locations in Europe (toll line) . . . . . .+31 (0)20 681 5792
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Asia/Pacific
Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9272 2627
China . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (010) 6564 5735
Japan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (3) 3335 8622
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 769 0543
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . (09) 356 6642
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (65) 291 7251
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 719 5589

E-mail  . . . . . . . . . . . . . . . . . . . . . . . . . . . . SureStore_Support@hp.com

FTP Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ftp.hp.com
Login:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . anonymous
Password:  . . . . . . . . . . . . . . . . . . . . . . . . . (Your email address)
Directory:  /pub/information_storage/surestore/cd-writer_plus

Telephone 
For telephone number updates:

http://www.hp.com/cpso-support/guide/psd/cscinfo.html

USA (Support available 24 hours a day, 7 days a week)
Literature and dealer referral . . . . . . . . . . . . . . . . 970-635-1500

During warranty period
Technical support  . . . . . . . . . . . . . . . . . . . . . . . . 970-635-1500

After warranty period (charges begin only when you connect to a Support Technician, 
prices are subject to change without notice)

Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . 800-810-0130
(Per incident fee of $25 US dollars charged to 
Visa, MasterCard or American Express)
U.S. only Technical Support. . . . . . . . . . . . . . . . . 900-555-1800
($2.50 per minute/maximum of $25. You must be 18 years
of age or have parental permission to call 900 numbers.)

Use these Technical Support numbers during and after your warranty period. No charge 
for technical support during warranty period. Per incident charge after warranty period.
Canada (M-F, 8:00-20:00 Eastern Time)

Technical support in English and French  . . . . . . 905-206-4663
Pour assistance en français et anglais  . . . . . . . . . 905-206-4663

Europe (M-F, 8:30-18:00 Central European Time)
Austria  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 06 60 63 86
Belgium
- Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 626 88 06
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 626 88 07
Czech Republic. . . . . . . . . . . . . . . . . . . . . . . . . . . 42 2 471 7321
Denmark. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39 29 40 99
Finland . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 03 47 288
France . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 43 62 3434
Germany. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0180 52 58 143
Hungary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36 1 252 4505
Ireland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 662 55 25
Italy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 2 641 0350
Netherlands  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 020 606 87 51
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Norway . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22 11 62 99
Portugal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 44 17 199
Russia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7095 923 5001
Spain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90 23 21 123
Sweden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 08 61 92 170
Switzerland (French, Italian, and German) . . . . 08 48 80 11 11
Turkey. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90 1 224 5925
United Kingdom. . . . . . . . . . . . . . . . . . . . . . . . . 0171 512 52 02
English language support from other countries+44 171 512 52 02

Latin America
Argentina (M-F, 8:30-19:30) . . . . . . . . . . . . . . (54) (1) 787 8080
Brazil (M-F, 8:00-19:00)  . . . . . . . . . . . . . . . . (55) (11) 829 6612
Chile (M-F, 8:30-18:30)  . . . . . . . . . . . . . . . (56) (2) 800 360999
Mexico (M-F, 8:30-18:30) . . . . . . . . . . . . . (52) (5) 800 22 14700
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (52) (5) 800 90 52900
Venezuela (M-F, 9:00-18:00). . . . . . . . . . . . . . (58) (2) 207 8488

Asia/Pacific
Australia (M-F 7am-7pm, Melbourne Time)  . . . (03) 8877 8000
China (M-F 8:30-17:30) . . . . . . . . . . . . . . . . . . (010)-6564 5959
 . . . . . . . . . . . . . . . . . Hotline (010)-6262 3888 extension 6101
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Product Service Center
 . . . . . . . . . . . . . . . . . . . Sigma Building, No. 49 Zhi Chun Road
 . . . . . . . . . . . . . . . . . . . Haidian District, Beijing 100080, P.R.C
Korea (M-F, 8:30-19:00)(02) 3270-0700 / 080-999-0700 (toll free)
New Zealand (M-F, 9am to 9pm Auckland Time)  (09) 356 6640
Singapore (M-F, 9:00-17:00) . . . . . . . . . . . . . . . . . (65) 272-5300
Taiwan (M-F, 8:30-17:30) . . . . . . . . . . . . . . . . . . . (02) 717-9609

FAX 
USA. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 970-667-0997
Asia/Pacific

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9272 4099
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 3270-0707
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . .(+61 3) 9272 4099
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (65) 274-2033
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)5140276

Returning a Drive
If your Hewlett-Packard product requires repair or replacement, call the 
appropriate number for your country from the list beginning page B-5 to receive 
instructions.
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1-14
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performance enhancement 3-5
power supply 1-2
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printer cable 1-14

returning B-6
selecting CDs 2-2
serial number B-2
sharing parallel port with printer 1-4–1-5,

3-3
supported discs A-4
system requirements A-1
using earphones or speakers 3-3

changing song order 6-8
changing text attributes 7-6
cleaning CD-Writer drive 2-4
compatibility A-1
compatibility problems 3-7
compatible parallel port 3-5, A-2, A-3
compression software 3-7
computer

identifying model B-2
processor speed A-1, A-2
system requirements A-1

connecting
audio cable 1-7
CD-Writer drive 1-1–1-15
CD-Writer drive to another computer

1-13, 1-14
data cable 1-6
power cord 1-2

connector
audio 1-7
parallel port 1-4, 1-6
printer port 1-4

contacting Customer Support B-1
contents, package 1-1
copy prevention feature 3-3
copying

audio CDs 8-1
DirectCD discs 8-2
files from CD in Simple Trax 9-15
files to CD with Simple Trax 9-2
mixed-mode CDs 8-2
photo CDs 8-2
video CDs 8-2

copying CDs
making mulitple copies 8-4
steps 8-3

copying files
scheduling 9-3
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to CD in Simple Trax 9-2
copying from CD to CD 3-3
copyright notice 6-2, 8-1
creating audio CDs 6-5
CTRL-ALT-DEL 2-3, 3-6
Customer Support, contacting B-1
customizing jewel case inserts 7-2
cycling power 1-8, 1-9, 3-1

D

data cable
connecting 1-6
disconnecting 1-14

defining text attributes 7-5
Device Manager 1-10, 3-6, A-1, B-2, B-3
digital audio extraction 6-4
dimensions A-6
Direct CD 3-5
DirectCD

sharing CD-R 4-3
starting 5-2

DirectCD discs
about formatting CD-RW disc 5-3
adding data 5-4, 5-5
ejecting 5-4
formatting 5-3

disaster recovery 10-1
disaster recovery set

creating 10-2
testing 10-3

disc labels
printing 7-8

disconnecting
audio cable 1-14
CD-Writer drive 1-13–1-14
data cable 1-14
printer cable 1-14

discs
sharing CD-R 4-3
sharing CD-RW 4-2
using CD-R 4-3
using CD-RW 4-1

displaying

grids 7-4
track numbers 7-8
track times 7-8

distortion
audio 3-3
video 3-4, ??–3-4

drive letter
changing 3-6
identifying 2-4

driver installation A-2
drivers

finding 3-8

E

earphones 3-3
Easy-CD Audio

Online Help 5-8, 6-10, 7-9, 8-5
wizard 6-3

Easy-CD Creator
sharing CD-R 4-4

eject button 2-1, 2-2
ejecting DirectCD discs 5-4
email 3-4
environmental specifications A-6
erasing files from CDs 5-5
error message

buffer underrun 3-4–3-5
cannot find CD 3-6
CD not recognized 1-10
unable to read 3-5

error rate A-4
event logs in Simple Trax 9-19

F

fax modem 3-4
files

copying automatically 9-3
copying from CD to hard drive 9-15
retrieving early versions 9-16
searching in Simple Trax 9-11
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files not recovered 10-9
firmware version B-2
fitting tracks on a page 7-8
formatting DirectCD discs 5-3

G

getting started 10-1

H

Handling CDs 2-3
hard drive

access time 3-5, A-2, A-3, A-4
compression software 3-7
speed A-2
storage requirements A-1
transfer rate A-1, A-2

Help
Easy-CD Audio 5-8, 6-10, 7-9, 8-5

high-pressure air 2-4
HP VersaWriter CD drive

uninstalling 1-12
humidity specifications A-6

I

I/O channel setting A-1
importing CDs into SimpleTrax 9-17
inserting a CD 2-1–2-2
inserting objects 7-6
installing application software 1-8–1-12
installing parallel driver files 3-8
Interchange 4-5
IRQ setting A-1, A-3

J

jewel case inserts
adding graphics 7-6
editing 7-2
editing text 7-6
graphics

OLE objects 7-6
making 7-2
positioning 7-4
printing 7-8
rulers and grids, using 7-3
viewing 7-2
zooming 7-3

jewel case layout 7-2
Page menu 7-2

L

listening to music CDs 1-7

M

maintenance 2-4
making a disc copy 8-4
making multiple copies 8-4
mastering application 4-4
measuring inserts and objects 7-3
memory A-1, A-2, B-3
model number, locating B-2
modifying CD layouts 6-8
moving CD-Writer drive to another computer

1-14
MSCDEX version 3-5
MultiRead CD-ROM 4-2
multi-session CD 3-5
music CDs 1-7

playing 6-9
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N

networks 3-4

O

OLE objects 7-6
opening CD layouts 6-9
opening tray 2-1
operating system

compatible A-1
identifying version B-3

P

package contents 1-1
Page menu 7-2
parallel port A-6, B-3

compatible 3-5, A-2, A-3
configuration 1-10, A-1
conflicting device 1-10–??, 1-11, 1-11–

1-12, A-3
connector 1-4, 1-6
ECP 1-10, 3-5, A-2, A-3
EPP 1-10, 3-5, A-2, A-3
minimum requirements A-1
sharing 1-4–1-5, 3-3
SPP 3-5, A-2, A-3

performance A-2–A-3, A-4
optimizing 3-7, A-3

playing music CDs 6-9
positioning objects 7-4
power cord

connecting 1-2
power loss while writing 2-4, 3-6
power management feature 3-2, 3-4
power requirements A-6
power supply 1-2

light 1-2, 1-12
power switch 1-3, 1-13
power-saving mode 1-3, 1-13
problems 1-12

unplugging 1-13
power switch 1-3, 1-13
power-saving mode 1-3, 1-13
printer

compatibility problems 3-7
monitor software 3-7
problems 1-11
sharing parallel port with CD-Writer

drive 1-4–1-5, 3-3
printer cable

connecting 1-5
disconnecting 1-14

printer monitor software 3-7
printer port connector 1-4
printer status monitor software 3-5, 3-7
printing 1-5

disc labels 7-8
jewel case inserts 7-8
problems 1-11
while playing audio CDs 3-3

processor speed A-1, A-2
product certification vi
programs

uninstalling 1-12

R

RAM. See memory
reading error 3-5
reading from CD

speed A-3, A-4
recording

CD to CD 3-3
power loss during 2-4, 3-6
while running other applications 3-4

recording audio tracks 6-3
recording wave files 6-5
recovering your data 10-4
refreshing the screen 1-11, 3-5
removing a CD 2-2
removing songs from CD layout 6-8
renaming songs in CD layout 6-8
returning a CD-Writer drive B-6
rewritable CDs 2-2, 3-5, A-5
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ruler option 7-3

S

saving CD layout 6-9
scheduling

changing a schedule 9-9
in Simple Trax 9-3
verifying a schedule 9-9

searching in Simple Trax 9-11
serial number B-2
sharing CD-R

created with DirectCD 4-3
created with Easy-CD Creator 4-4

sharing CD-R discs 4-3
sharing CD-RW discs 4-2
sharing parallel port 1-4–1-5, 3-3
Simple Trax 9-1

browsing your CD 9-10
changing a schedule 9-9
changing the display 9-19
copying files from CD 9-15
copying files to CD 9-2
early file versions 9-16
event logs 9-19
finding files on CD 9-11
importing a CD 9-17
scheduling 9-3
searching for files 9-11
using the wizard 9-5
verifying a schedule 9-9
viewing CD contents 9-10

snapping objects to grid 7-4
software

installing 1-8–1-12
uninstalling 1-12

software compression 3-7
Software Installation CD

driver files 3-8
songs

removing from CD layout 6-8
renaming 6-8

sound board 1-7, 3-3, B-3
sound system 1-7

sound-muting feature 3-3
speakers 3-3
speed

reading from CD A-3, A-4
writing to CD 3-5, A-3, A-4

switch box 1-10, 1-13, 3-2
system requirements A-1

T

temp directory
changing location 8-4

temperature specifications A-6
test options

CD Copier 8-3
text attributes

changing 7-6
defining 7-5

track column lists 7-7
track titles

arranging 7-7
track-at-once mode 8-1
tracks

combining with wave files 6-2
transfer rate A-1, A-2, A-4
tray, opening and closing 2-1, 2-2
troubleshooting

audio distortion 3-3
cable connections 1-8, 1-9–1-10, 3-1–3-2
compatibility problems 3-7
copying from CD to CD 3-3
Customer Support B-1
hardware connections 1-8, 1-9–1-10, 3-1–

3-2
inserting CDs 2-2
IRQ conflict A-3
not recognizing CD-Writer drive 1-11–

1-12
parallel port configuration 1-10–??, 1-11,

1-11–1-12, A-3
power supply 1-12
printing 1-11, 3-7
reading error 3-5
returning your CD-Writer drive B-6
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video distortion 3-4, ??–3-4
writing to CD 3-4

types of CDs that can be copied 8-1

U

uninstalling 1-12

V

vibration specifications A-6
video card 3-4, ??–3-4
video distortion 3-4, ??–3-4
viewing jewel case inserts 7-2
volume control 3-3

W

wave files 3-3, 6-2
combining with audio tracks 6-2
pre-recording from audio tracks 6-6
recording 6-5
specifications 6-5

windows explorer 6-4
wizard

copying files in Simple Trax 9-5
making music CDs 6-3

write-once CDs 2-3, 3-4, 3-5, A-5
writing to CD 3-3, 3-4

power loss 3-6
power loss while writing 2-4
speed 3-5, A-3, A-4
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